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1 INTRODUCTION 

PLAXIS is a finite element package that has been developed specifically for the analysis 
of deformation and stability in geotechnical engineering projects. The simple graphical 
input procedures enable a quick generation of complex finite element models, and the 
enhanced output facilities provide a detailed presentation of computational results. The 
calculation itself is fully automated and based on robust numerical procedures. This 
concept enables new users to work with the package after only a few hours of training. 

Though the various lessons deal with a wide range of interesting practical applications 
this Tutorial Manual is intended to help new users become familiar with PLAXIS. The 
lessons should therefore not be used as a basis for practical projects. 

Users are expected to have a basic understanding of soil mechanics and should be able 
to work in a Windows environment. It is strongly recommended that the lessons are 
followed in the order that they appear in the manual. The tutorial lessons are also 
available in the examples folder of the PLAXIS program directory and can be used to 
check your results. 

The Tutorial Manual does not provide theoretical background information on the finite 
element method, nor does it explain the details of the various soil models available in 
the program. The latter can be found in the Material Models Manual, as included in the 
full manual, and theoretical background is given in the Scientific Manual. For detailed 
information on the available program features, the user is referred to the Reference 
Manual. In addition to the full set of manuals, short courses are organised on a regular 
basis at several places in the world to provide hands-on experience and background 
information on the use of the program. 
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2 GETTING STARTED 

This chapter describes some of the notation and basic input procedures that are used in 
PLAXIS. In the manuals, menu items or windows specific items are printed in Italics. 
Whenever keys on the keyboard or text buttons on the screen need to be pressed or 
clicked, this is indicated by the name of the key or button in brackets, (for example the 
<Enter> key). 

2.1 INSTALLATION 

For the installation procedure the user is referred to the General Information section in 
this manual. 

2.2 GENERAL MODELLING ASPECTS 

For each new project to be analysed it is important to create a geometry model first. A 
geometry model is a 2D representation of a real three-dimensional problem and consists 
of points, lines and clusters. A geometry model should include a representative division 
of the subsoil into distinct soil layers, structural objects, construction stages and 
loadings. The model must be sufficiently large so that the boundaries do not influence 
the results of the problem to be studied. The three types of components in a geometry 
model are described below in more detail.  

Points: 
Points form the start and end of lines. Points can also be used for the 
positioning of anchors, point forces, point fixities and for local refinements of 
the finite element mesh.  

Lines: 
Lines are used to define the physical boundaries of the geometry, the model 
boundaries and discontinuities in the geometry such as walls or shells, 
separations of distinct soil layers or construction stages. A line can have several 
functions or properties. 

Clusters: 
Clusters are areas that are fully enclosed by lines. PLAXIS automatically 
recognises clusters based on the input of geometry lines. Within a cluster the 
soil properties are homogeneous. Hence, clusters can be regarded as parts of 
soil layers. Actions related to clusters apply to all elements in the cluster. 

After the creation of a geometry model, a finite element model can automatically be 
generated, based on the composition of clusters and lines in the geometry model. In a 
finite element mesh three types of components can be identified, as described below. 
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Elements: 
During the generation of the mesh, clusters are divided into triangular elements. 
A choice can be made between 15-node elements and 6-node elements. The 
powerful 15-node element provides an accurate calculation of stresses and 
failure loads. In addition, 6-node triangles are available for a quick calculation 
of serviceability states. Considering the same element distribution (for example 
a default coarse mesh generation) the user should be aware that meshes 
composed of 15-node elements are actually much finer and much more flexible 
than meshes composed of 6-node elements, but calculations are also more time 
consuming. In addition to the triangular elements, which are generally used to 
model the soil, compatible plate elements, geogrid elements and interface 
elements may be generated to model structural behaviour and soil-structure 
interaction. 

Nodes: 
A 15-node element consists of 15 nodes and a 6-node triangle is defined by 6 
nodes. The distribution of nodes over the elements is shown in Figure 2.1. 
Adjacent elements are connected through their common nodes. During a finite 
element calculation, displacements (ux and uy) are calculated at the nodes. 
Nodes may be pre-selected for the generation of load-displacement curves. 

Stress points: 
In contrast to displacements, stresses and strains are calculated at individual 
Gaussian integration points (or stress points) rather than at the nodes. A 15-
node triangular element contains 12 stress points as indicated in Figure 2.1a 
and a 6-node triangular element contains 3 stress points as indicated in Figure 
2.1b. Stress points may be pre-selected for the generation of stress paths or 
stress-strain diagrams. 

 

Figure 2.1  Nodes and stress points 
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2.3 INPUT PROCEDURES 

In PLAXIS, input is specified by a mixture of mouse clicking and moving, and by 
keyboard input. In general, distinction can be made between four types of input: 

 Input of geometry objects  (e.g. drawing a soil layer) 

Input of text   (e.g. entering a project name) 

Input of values   (e.g. entering the soil unit weight) 

Input of selections  (e.g. choosing a soil model) 

The mouse is generally used for drawing and selection purposes, whereas the keyboard 
is used to enter text and values. 

2.3.1 INPUT OF GEOMETRY OBJECTS 
The creation of a geometry model is based on the input of points and lines. This is done 
by means of a mouse pointer in the draw area. Several geometry objects are available 
from the menu or from the toolbar. The input of most of the geometry objects is based 
on a line drawing procedure. In any of the drawing modes, lines are drawn by clicking 
the left mouse button in the draw area. As a result, a first point is created. On moving the 
mouse and left clicking with the mouse again, a new point is created together with a line 
from the previous point to the new point. The line drawing is finished by clicking the 
right mouse button, or by pressing the <Esc> key on the keyboard. 

2.3.2 INPUT OF TEXT AND VALUES 
As for any software, some input of values and text is required. The required input is 
specified in the edit boxes. Multiple edit boxes for a specific subject are grouped in 
windows. The desired text or value can be typed on the keyboard, followed by the 
<Enter> key or the <Tab> key. As a result, the value is accepted and the next input field 
is highlighted. In some countries, like The Netherlands, the decimal dot in floating point 
values is represented by a comma. The type of representation that occurs in edit boxes 
and tables depends on the country setting of the operating system. Input of values must 
be given in accordance with this setting. 

Many parameters have default values. These default values may be used by pressing the 
<Enter> key without other keyboard input. In this manner, all input fields in a window 
can be entered until the OK button is reached. Clicking the OK button confirms all 
values and closes the window. Alternatively, selection of another input field, using the 
mouse, will result in the new input value being accepted. Input values are confirmed by 
left clicking the OK button with the mouse.  

Pressing the <Esc> key or left clicking the Cancel button will cancel the input and 
restore the previous or default values before closing the window.  

The spin edit feature is shown in Figure 2.2. Just like a normal input field a value can be 
entered by means of the keyboard, but it is also possible to left-click the ▲ or ▼ arrows 



TUTORIAL MANUAL 

at the right side of each spin edit to increase or decrease its value by a predefined 
amount. 

 

Figure 2.2  Spin edits 

2.3.3 INPUT OF SELECTIONS 
Selections are made by means of radio buttons, check boxes or combo boxes as 
described below. 

 

Figure 2.3  Radio buttons  

 

Figure 2.4  Check boxes 

 

Figure 2.5  Combo boxes 

2-4 PLAXIS Version 8 



GETTING STARTED 

2-5 

Radio buttons: 
In a window with radio buttons only one item may be active. The active 
selection is indicated by a black dot in the white circle in front of the item. 
Selection is made by clicking the left mouse button in the white circle or by 
using the up and down arrow keys on the keyboard. When changing the 
existing selection to one of the other options, the 'old' selection will be 
deselected. An example of a window with radio buttons is shown in Figure 2.3. 
According to the selection in Figure 2.3 the Pore pressure distribution is set to 
General phreatic level. 

Check boxes: 
In a window with check boxes more than one item may be selected at the same 
time. The selection is indicated by a black tick mark in a white square. 
Selection is made by clicking the left mouse button in the white square or by 
pressing the space bar on the keyboard. Another click on a preselected item 
will deselect the item. An example of three check boxes is shown in Figure 2.4.  

Combo boxes: 
A combo box is used to choose one item from a predefined list of possible 
choices. An example of a window with combo boxes is shown in Figure 2.5. As 
soon as the ▼ arrow at the right hand side of the combo box is left clicked with 
the mouse, a pull down list occurs that shows the possible choices. A combo 
box has the same functionality as a group of radio buttons but it is more 
compact. 

2.3.4 STRUCTURED INPUT 
The required input is organised in a way to make it as logical as possible. The Windows 
environment provides several ways of visually organising and presenting information on 
the screen. To make the reference to typical Windows elements in the next chapters 
easier, some types of structured input are described below. 

Page control and tab sheets: 
An example of a page control with three tab sheets is shown in Figure 2.6. In 
this figure the second tab sheet for the input of the model parameters of the 
Mohr-Coulomb soil model is active. Tab sheets are used to handle large 
amounts of different types of data that do not all fit in one window. Tab sheets 
can be activated by left-clicking the corresponding tab or using <Ctrl><Tab> 
on the keyboard.  

Group boxes: 
Group boxes are rectangular boxes with a title. They are used to cluster input 
items that have common features. In Figure 2.6, the active tab sheet contains 
three group boxes named Stiffness, Strength and Alternatives. 



TUTORIAL MANUAL 

 

Figure 2.6  Page control and tab sheets 

2.4 STARTING THE PROGRAM 

It is assumed that the program has been installed using the procedures described in the 
General Information part of the manual. It is advisable to create a separate directory in 
which data files are stored. PLAXIS can be started by double-clicking the Plaxis input 
icon in the PLAXIS program group. The user is asked whether to define a new problem or 
to retrieve a previously defined project. If the latter option is chosen, the program lists 
four of the most recently used projects from which a direct choice can be made. 
Choosing the item <<more files>> that appears first in this list will give a file requester 
from which the user can choose any previously defined project for modification. 

2.4.1 GENERAL SETTINGS 
If a new project is to be defined, the General settings window as shown in Figure 2.7 
appears. This window consists of two tab sheets. In the first tab sheet miscellaneous 
settings for the current project have to be given. A filename has not been specified here; 
this can be done when saving the project.  

The user can enter a brief description of the problem as the title of the project as well as 
a more extended description in the Comments box. The title is used as a proposed file 
name and appears on output plots. The comments box is simply a convenient place to 
store information about the analysis. In addition, the type of analysis and the type of 
elements must be specified. Optionally, a separate acceleration, in addition to gravity, 
can be specified for a pseudo-static simulation of dynamics forces. 

The second tab sheet is shown in Figure 2.8. In addition to the basic units of Length, 
Force and Time, the minimum dimensions of the draw area must be given here, such 
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that the geometry model will fit the draw area. The general system of axes is such that 
the x-axis points to the right, the y-axis points upward and the z-axis points towards the 
user. In PLAXIS a two-dimensional model is created in the (x,y)-plane. The z-axis is used 
for the output of stresses only. Left is the lowest x-coordinate of the model, Right the 
highest x-coordinate, Bottom the lowest y-coordinate and Top the highest y-coordinate of 
the model.  

 

Figure 2.7  General settings - Project tab sheet 

 

Figure 2.8  General settings - Dimensions tab sheet 

In practice, the draw area resulting from the given values will be larger than the values 
given in the four spin edits. This is partly because PLAXIS will automatically add a small 
margin to the dimensions and partly because of the difference in the width/height ratio 
between the specified values and the screen. 
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2.4.2 CREATING A GEOMETRY MODEL 
When the general settings are entered and the OK button is clicked, the main Input  
window appears. This main window is shown in Figure 2.9. The most important parts of 
the main window are indicated and briefly discussed below. 

 

Main Menu

Toolbar (Geometry)
Toolbar (General)

Ruler

Ruler

Draw area

Origin

Manual Input Cursor position indicator

Figure 2.9  Main window of the Input program 

Main menu: 
The main menu contains all the options that are available from the toolbars, and 
some additional options that are not frequently used. 

Tool bar (General): 
This tool bar contains buttons for general actions like disk operations, printing, 
zooming or selecting objects. It also contains buttons to start the other 
programs of the PLAXIS package (Calculations, Output and Curves). 

Tool bar (Geometry): 
This tool bar contains buttons for actions that are related to the creation of a 
geometry model. The buttons are ordered in such a way that, in general, 
following the buttons on the tool bar from the left to the right results in a 
completed geometry model. 
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Rulers: 
At both the left and the top of the draw area, rulers indicate the physical 
coordinates, which enables a direct view of the geometry dimensions. 

Draw area: 
The draw area is the drawing sheet on which the geometry model is created. 
The draw area can be used in the same way as a conventional drawing program. 
The grid of small dots in the draw area can be used to snap to regular positions. 

Origin: 
If the physical origin is within the range of given dimensions, it is represented 
by a small circle, with an indication of the x- and y-axes.  

Manual input: 
If drawing with the mouse does not give the desired accuracy, then the Manual 
input line can be used. Values for x- and y-coordinates can be entered here by 
typing the corresponding values separated by a space. The manual input can 
also be used to assign new coordinates to a selected point or refer to an existing 
geometry point by entering its point number. 

Cursor position indicator: 
The cursor position indicator gives the current position of the mouse cursor 
both in physical units and screen pixels. 

Some of the objects mentioned above can be removed by deselecting the corresponding 
item from the View menu. 

For both toolbars, the name and function of the buttons is shown after positioning the 
mouse cursor on the corresponding button and keeping the mouse cursor still for about a 
second; a hint will appear in a small yellow box below the button. The available hints 
for both toolbars are shown in Figure 2.10. In this Tutorial Manual, buttons will be 
referred to by their corresponding hints. 
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Figure 2.10  Toolbars 

For detailed information on the creation of a complete geometry model, the reader is 
referred to the various lessons that are described in this Tutorial Manual. 
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3 SETTLEMENT OF A CIRCULAR FOOTING ON SAND (LESSON 1) 

In the previous chapter some general aspects and basic features of the PLAXIS program 
were presented. In this chapter a first application is considered, namely the settlement of 
a circular foundation footing on sand. This is the first step in becoming familiar with the 
practical use of the program. The general procedures for the creation of a geometry 
model, the generation of a finite element mesh, the execution of a finite element 
calculation and the evaluation of the output results are described here in detail. The 
information provided in this chapter will be utilised in the later lessons. Therefore, it is 
important to complete this first lesson before attempting any further tutorial examples. 

3.1 GEOMETRY 

 

Figure 3.1  Geometry of a circular footing on a sand layer 

A circular footing with a radius of 1.0 m is placed on a sand layer of 4.0 m thickness as 
shown in Figure 3.1. Under the sand layer there is a stiff rock layer that extends to a 
large depth. The purpose of the exercise is to find the displacements and stresses in the 
soil caused by the load applied to the footing. Calculations are performed for both rigid 
and flexible footings. The geometry of the finite element model for these two situations 
is similar. The rock layer is not included in the model; instead, an appropriate boundary 
condition is applied at the bottom of the sand layer. To enable any possible mechanism 
in the sand and to avoid any influence of the outer boundary, the model is extended in 
horizontal direction to a total radius of 5.0 m.  

3.2 CASE A: RIGID FOOTING 

In the first calculation, the footing is considered to be very stiff and rough. In this 
calculation the settlement of the footing is simulated by means of a uniform indentation 
at the top of the sand layer instead of modelling the footing itself. This approach leads to 
a very simple model and is therefore used as a first exercise, but it also has some 
disadvantages. For example, it does not give any information about the structural forces 
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in the footing. The second part of this lesson deals with an external load on a flexible 
footing, which is a more advanced modelling approach. 

3.2.1 CREATING THE INPUT 
Start PLAXIS by double-clicking the icon of the Input program. A Create/Open project 
dialog box will appear in which you can select an existing project or create a new one. 
Choose a New project and click the OK button (see Figure 3.2). Now the General 
settings window appears, consisting of the two tab sheets Project and Dimensions (see 
Figure 3.3 and Figure 3.4). 

 

Figure 3.2  Create/Open project dialog box 

General Settings 
The first step in every analysis is to set the basic parameters of the finite element model. 
This is done in the General settings window. These settings include the description of 
the problem, the type of analysis, the basic type of elements, the basic units and the size 
of the draw area.  

 

Figure 3.3  Project tab sheet of the General settings window 

To enter the appropriate settings for the footing calculation follow these steps: 
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• In the Project tab sheet, enter “Lesson 1” in the Title box and type “Settlements 
of a circular footing” in the Comments box.  

• In the General box the type of the analysis (Model) and the basic element type 
(Elements) are specified. Since this lesson concerns a circular footing, choose 
Axisymmetry from the Model combo box and select 15-node from the Elements 
combo box.  

• The Acceleration box indicates a fixed gravity angle of -90°, which is in the 
vertical direction (downward). In addition to the normal gravity, independent 
acceleration components may be entered for pseudo-dynamic analyses. These 
values should be kept zero for this exercise. Click the Next button below the tab 
sheets or click the Dimensions tab. 

• In the Dimensions tab sheet, keep the default units in the Units box (Unit of 
Length = m; Unit of Force = kN; Unit of Time = day).  

• In the Geometry dimensions box the size of the required draw area must be 
entered. When entering the upper and lower coordinate values of the geometry 
to be created, PLAXIS will add a small margin so that the geometry will fit well 
within the draw area. Enter 0.0, 5.0, 0.0 and 4.0 in the Left, Right, Bottom and 
Top edit boxes respectively. 

• The Grid box contains values to set the grid spacing. The grid provides a 
matrix of dots on the screen that can be used as reference points. It may also be 
used for snapping to regular points during the creation of the geometry. The 
distance between the dots is determined by the Spacing value. The spacing of 
snapping points can be further divided into smaller intervals by the Number of 
intervals value. Enter 1.0 for the spacing and 1 for the intervals. 

• Click the OK button to confirm the settings. Now the draw area appears in 
which the geometry model can be drawn. 

 

Figure 3.4  Dimensions tab sheet of the General settings window 
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Hint: In the case of a mistake or for any other reason that the general settings need 

to be changed, you can access the General settings window by selecting the 
General settings option from the File menu. 

 

Geometry Contour 
Once the general settings have been completed, the draw area appears with an indication 
of the origin and direction of the system of axes. The x-axis is pointing to the right and 
the y-axis is pointing upward. A geometry can be created anywhere within the draw 
area. To create objects, you can either use the buttons from the toolbar or the options 
from the Geometry menu. For a new project, the Geometry line button is already active. 
Otherwise this option can be selected from the second toolbar or from the Geometry 
menu. In order to construct the contour of the proposed geometry, follow these steps: 

Select the Geometry line option (already pre-selected). 

  

• Position the cursor (now appearing as a pen) at the origin of the axes. Check 
that the units in the status bar read 0.0 x 0.0 and click the left mouse button 
once. The first geometry point (number 0) has now been created. 

• Move along the x-axis to position (5.0; 0.0). Click the left mouse button to 
generate the second point (number 1). At the same time the first geometry line 
is created from point 0 to point 1. 

• Move upward to position (5.0; 4.0) and click again. 

• Move to the left to position (0.0; 4.0) and click again.  

• Finally, move back to the origin (0.0; 0.0) and click the left mouse button 
again. Since the latter point already exists, no new point is created, but only an 
additional geometry line is created from point 3 to point 0. PLAXIS will also 
detect a cluster (area that is fully enclosed by geometry lines) and will give it a 
light colour. 

• Click the right mouse button to stop drawing.  

 
Hint: Mispositioned points and lines can be modified or deleted by first choosing 

the Selection button from the toolbar. To move a point or line, select the point 
or the line and drag it to the desired position. To delete a point or a line, select 
the point or the line and press the <Del> button on the keyboard.   

> Unwanted drawing operations can be removed by clicking the Undo button 
from the toolbar or by selecting the Undo option from the Edit menu or by 
pressing <Ctrl><Z> on the keyboard. 

> Lines can be drawn perfectly horizontal or vertical by holding down the 
<Shift> key on the keyboard while moving the cursor. 
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The proposed geometry does not include plates, hinges, geogrids, interfaces, anchors or 
tunnels. Hence, you can skip these buttons on the second toolbar. 

 
Hint: The full geometry model has to be completed before a finite element mesh 

can be generated. This means that boundary conditions and model parameters 
must be entered and applied to the geometry model first. 

 

Boundary Conditions 
Boundary conditions can be found in the centre part of the second toolbar and in the 
Loads menu.  For deformation problems two types of boundary conditions exist: 
Prescribed displacements and prescribed forces (loads).  

In principle, all boundaries must have one boundary condition in each direction. That is 
to say, when no explicit boundary condition is given to a certain boundary (a free 
boundary), the natural condition applies, which is a prescribed force equal to zero and a 
free displacement. 

To avoid the situation where the displacements of the geometry are undetermined, some 
points of the geometry must have prescribed displacements. The simplest form of a 
prescribed displacement is a fixity (zero displacement), but non-zero prescribed 
displacements may also be given. In this problem the settlement of the rigid footing is 
simulated by means of non-zero prescribed displacements at the top of the sand layer. 

 

Figure 3.5  Geometry model in the Input window 
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To create the boundary conditions for this lesson, follow these steps: 

Click the Standard fixities button on the toolbar or choose the Standard fixities 
option from the Loads menu to set the standard boundary conditions.  

• As a result PLAXIS will generate a full fixity at the base of the geometry and 
roller conditions at the vertical sides (ux=0; uy=free). A fixity in a certain 
direction appears on the screen as two parallel lines perpendicular to the fixed 
direction. Hence, roller supports appear as two vertical parallel lines and full 
fixity appears as crosshatched lines. 

 
Hint: The Standard fixities option is suitable for most geotechnical applications. It 

is a fast and convenient way to input standard boundary conditions. 
 

Select the Prescribed displacements button from the toolbar or select the 
corresponding option from the Loads menu.  

• Move the cursor to point (0.0; 4.0) and click the left mouse button. 

• Move along the upper geometry line to point (1.0; 4.0) and click the left mouse 
button again. 

• Click the right button to stop drawing. 

In addition to the new point (4), a prescribed downward displacement of 1 unit (1.0 m) 
in a vertical direction and a fixed horizontal displacement are created at the top of the 
geometry. Prescribed displacements appear as a series of arrows starting from the 
original position of the geometry and pointing in the direction of movement. 

 
Hint: The input value of a prescribed displacement may be changed by first clicking 

the Selection button and then double-clicking the line at which a prescribed 
displacement is applied. On selecting Prescribed displacements from the 
Select dialog box, a new window will appear in which the changes can be 
made. 

> The prescribed displacement is actually activated when defining the 
calculation stages (Section 3.2.2). Initially it is not active. 

 

Material data sets 
In order to simulate the behaviour of the soil, a suitable soil model and appropriate 
material parameters must be assigned to the geometry. In PLAXIS, soil properties are 
collected in material data sets and the various data sets are stored in a material database. 
From the database, a data set can be appointed to one or more clusters. For structures 
(like walls, plates, anchors, geogrids, etc.) the system is similar, but different types of 
structures have different parameters and therefore different types of data sets. 

PLAXIS distinguishes between material data sets for Soil & Interfaces, Plates, Anchors 
and Geogrids. 
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The creation of material data sets is generally done after the input of boundary 
conditions. Before the mesh is generated, all material data sets should have been defined 
and all clusters and structures must have an appropriate data set assigned to them. 

Table 3.1  Material properties of the sand layer 

Parameter Name Value Unit 
Material model 
Type of material behaviour 
Soil unit weight above phreatic level 
Soil unit weight below phreatic level 
Permeability in horizontal direction 
Permeability in vertical direction 
Young's modulus (constant) 
Poisson's ratio 
Cohesion (constant) 
Friction angle 
Dilatancy angle 

Model 
Type 
γunsat

γsat

kx

ky

Eref

ν 
cref

ϕ 
ψ 

Mohr-Coulomb 
Drained 
17.0 
20.0 
1.0 
1.0 
13000 
0.3 
1.0 
31.0 
0.0 

- 
- 
kN/m3

kN/m3

m/day 
m/day 
kN/m2

- 
kN/m2

° 
° 

 
The input of material data sets can be selected by means of the Material Sets button on 
the toolbar or from the options available in the Materials menu. 

To create a material set for the sand layer, follow these steps: 

Select the Material Sets button on the toolbar. 

  

• Click the New button at the lower side of the Material Sets window. A new 
dialog box will appear with three tab sheets: General, Parameters and 
Interfaces (see Figure 3.6 and Figure 3.7). 

• In the Material Set box of the General tab sheet, write “Sand” in the 
Identification box. 

• Select Mohr-Coulomb from the Material model combo box and Drained from 
the Material type combo box (default parameters). 

• Enter the proper values in the General properties box and the Permeability box 
according to the material properties listed in Table 3.1. 

• Click the Next button or click the Parameters tab to proceed with the input of 
model parameters. The parameters appearing on the Parameters tab sheet 
depend on the selected material model (in this case the Mohr-Coulomb model). 

See the Material Models manual for a detailed description of different soil models and 
their corresponding parameters. 
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Figure 3.6  General tab sheet of the soil and interface data set window 

 

Figure 3.7  Parameters tab sheet of the soil and interface data set window 
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• Enter the model parameters of Table 3.1 in the corresponding edit boxes of the 
Parameters tab sheet. 

• Since the geometry model does not include interfaces, the third tab sheet can be 
skipped. Click the OK button to confirm the input of the current material data 
set. Now the created data set will appear in the tree view of the Material Sets 
window. 

• Drag the data set “Sand” from the Material Sets window (select it and hold 
down the left mouse button while moving) to the soil cluster in the draw area 
and drop it (release the left mouse button). Notice that the cursor changes shape 
to indicate whether or not it is possible to drop the data set. Correct assignment 
of a data set to a cluster is indicated by a change in colour of the cluster. 

• Click the OK button in the Material Sets window to close the database. 

 
Hint: PLAXIS distinguishes between a project database and a global database of 

material sets. Data sets may be exchanged from one project to another using 
the global database. The data sets of all lessons in this Tutorial Manual are 
stored in the global database during the installation of the program. To copy 
an existing data set, click the Global >>> button of the Material Sets 
window. Drag the appropriate data set (in this case “Lesson 1 sand”) from the 
tree view of the global database to the project database and drop it. Now the 
global data set is available for the current project. Similarly, data sets created 
in the project database may be dragged and dropped in the global database. 

 
 

 
Hint: Existing data sets may be changed by opening the material sets window, 

selecting the data set to be changed from the tree view and clicking the Edit 
button. As an alternative, the material sets window can be opened by double-
clicking a cluster and clicking the Change button behind the Material set box 
in the properties window. A data set can now be assigned to the 
corresponding cluster by selecting it from the project database tree view and 
clicking the Apply button.  

> The program performs a consistency check on the material parameters and 
will give a warning message in the case of a detected inconsistency in the 
data. 

 

Mesh Generation  
When the geometry model is complete, the finite element model (or mesh) can be 
generated. PLAXIS allows for a fully automatic mesh generation procedure, in which the 
geometry is divided into elements of the basic element type and compatible structural 
elements, if applicable.  
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Figure 3.8  Axisymmetric finite element mesh of the geometry around the footing 

The mesh generation takes full account of the position of points and lines in the 
geometry model, so that the exact position of layers, loads and structures is accounted 
for in the finite element mesh. The generation process is based on a robust triangulation 
principle that searches for optimised triangles and which results in an unstructured mesh. 
Unstructured meshes are not formed from regular patterns of elements. The numerical 
performance of these meshes, however, is usually better than structured meshes with 
regular arrays of elements. In addition to the mesh generation itself, a transformation of 
input data (properties, boundary conditions, material sets, etc.) from the geometry model 
(points, lines and clusters) to the finite element mesh (elements, nodes and stress points) 
is made. 

In order to generate the mesh, follow these steps: 

Click the Generate mesh button in the toolbar or select the Generate option 
from the Mesh menu.  

After the generation of the mesh a new window is opened (Output window) in 
which the generated mesh is presented (see Figure 3.8). 

• Click the Update button to return to the geometry input mode. 

 
Hint: The Update button must always be used to return to the geometry input, even 

if the result from the mesh generation is not satisfactory. 
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Hint: By default, the Global coarseness of the mesh is set to Coarse, which is 

adequate as a first approach in most cases. The Global coarseness setting can 
be changed in the Mesh menu. In additional options are available to refine the 
mesh globally or locally. 

> At this stage of input it is still possible to modify parts of the geometry or to 
add geometry objects. If modifications are made at this stage, then the finite 
element mesh has to be regenerated. 

 

If necessary, the mesh can be optimised by performing global or local refinements. 
Mesh refinements are considered in some of the other lessons. Here it is suggested that 
the current finite element mesh is accepted. 

Initial Conditions 
Once the mesh has been generated, the finite element model is complete. Before starting 
the calculations, however, the initial conditions must be generated. In general, the initial 
conditions comprise the initial groundwater conditions, the initial geometry 
configuration and the initial effective stress state. The sand layer in the current footing 
project is dry, so there is no need to enter groundwater conditions. The analysis does, 
however, require the generation of initial effective stresses by means of the K0 
procedure.  

The initial conditions are entered in separate modes of the Input program. In order to 
generate the initial conditions properly, follow these steps: 

Click the Initial conditions button on the toolbar or select the Initial 
conditions option from the Initial menu. 

• First a small window appears showing the default value of the unit weight of 
water (10 kN/m3). Click OK to accept the default value. The groundwater 
conditions mode appears. Note that the toolbar and the background of the 
geometry have changed compared to the geometry input mode. 

The initial conditions option consists of two different modes: The water pressures mode 
and the geometry configuration mode. Switching between these two modes is done by 
the 'switch' in the toolbar. 

Since the current project does not involve water pressures, proceed to the 
geometry configuration mode by clicking the right hand side of the 'switch' 
(Initial stresses and geometry configuration). A phreatic level is automatically 
placed at the bottom of the geometry. 

 

Click the Generate initial stresses button (red crosses) in the toolbar or select 
the Initial stresses option from the Generate menu. The K0 procedure dialog 
box appears. 

• Keep the total multiplier for soil weight, ΣMweight, equal to 1.0. This means 
that the full weight of the soil is applied for the generation of initial stresses. 
Accept the default values of K0 as suggested by PLAXIS and click OK. 
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Figure 3.9  Initial stress field in the geometry around the footing 

 
Hint: The K0 procedure may only be used for horizontally layered geometries with 

a horizontal ground surface and, if applicable, a horizontal phreatic level. See 
Appendix A or the Reference Manual for more information on the K0 
procedure. 

> The default value of K0 is based on Jaky's formula: K0 = 1 - sinϕ. If the value 
was changed, the default value can be regained by entering a negative value 
for K0.  

• After the generation of the initial stresses the Output window is opened in 
which the effective stresses are presented as principal stresses (see Figure 3.9). 
The length of the lines indicates the relative magnitude of the principal stresses 
and the orientation of the lines indicates the principal directions. Click the 
Update button to return to the Input program geometry configuration mode. 

After the generation of the initial stresses, the calculation can be defined. After 
clicking the Calculate button, the user is asked to save the data on the hard 
disk. Click the Yes button. The file requester now appears. Enter an appropriate 
file name and click the Save button. 

3.2.2 PERFORMING CALCULATIONS 
After clicking the Calculate button and saving the input data, the Input program is 
closed and the Calculations program is started. The Calculations program may be used 
to define and execute calculation phases. It can also be used to select calculated phases 
for which output results are to be viewed. 

The Calculations window consists of a menu, a toolbar, a set of tab sheets and a list of 
calculation phases, as indicated in Figure 3.10.  
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Figure 3.10  The Calculations window with the General tab sheet 

The tab sheets (General, Parameters and Multipliers) are used to define a calculation 
phase. This can be a loading, construction or excavation phase, a consolidation period or 
a safety analysis. For each project multiple calculation phases can be defined. All 
defined calculation phases appear in the list at the lower part of the window. The tab 
sheet Preview can be used to show the actual state of the geometry. A preview is only 
available after calculation of the selected phase. 

When the Calculations program is started directly after the input of a new project, a first 
calculation phase is automatically inserted. In order to simulate the settlement of the 
footing in this analysis, a plastic calculation is required. PLAXIS has a convenient 
procedure for automatic load stepping, which is called Load Advancement. This 
procedure can be used for most practical applications. Within the plastic calculation, the 
prescribed displacements are activated to simulate the indentation of the footing. In 
order to define the calculation phase, follow these steps: 

• In the Phase ID box write (optionally) an appropriate name for the current 
calculation phase (for example “Indentation”) and select the phase from which 
the current phase should start (in this case the calculation can only start from 
phase 0 - Initial phase). 

• In the General tab sheet, select Plastic from the Calculation type combo box. 

• Click the Parameters button or click the Parameters tab. The Parameters tab 
sheet contains the calculation control parameters, as indicated in Figure 3.11.  

• Keep the default value for the maximum number of Additional steps (250) and 
select the Standard setting from the Iterative procedure box. See the Reference 
Manual for more information about the calculation control parameters. 
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Figure 3.11  The Calculations window with the Parameters tab sheet 

• From the Loading input box, select Staged Construction. 

• Click the Define button. The Staged Construction window appears, showing 
the currently active geometry configuration.  

• Select the prescribed displacement by double-clicking the top line. A dialog 
box will appear.  

 

Figure 3.12  The Prescribed Displacements dialog box in the Staged Construction 
window 
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• In the Prescribed Displacement dialog box the magnitude and direction of the 
prescribed displacement can be specified, as indicated in Figure 3.12. In this 
case enter a Y-value of –0.1 in both input fields, signifying a downward 
displacement of 0.1 m. All X-values should remain zero. Click OK. 

• Now click the Update button to return to the Parameters tab sheet of the 
calculations window. 

The calculation definition is now complete. Before starting the first calculation it is 
advisable to select nodes or stress points for a later generation of load-displacement 
curves or stress and strain diagrams. To do this, follow these steps: 

Click the Select points for curves button on the toolbar. As a result, a window is 
opened, showing all the nodes in the finite element model.  

• Select the node at the top left corner. The selected node will be indicated by 'A'. 
Click the Update button to return to the Calculations window. 

• In the Calculations window, click the Calculate button. This will start the 
calculation process. All calculation phases that are selected for execution, as 
indicated by the blue arrow (→) (only one phase in this case) will, in principle, 
be executed in the order controlled by the Start from phase parameter. 

 

Figure 3.13  The calculations info window 

 
Hint: The Calculate button is only visible if a calculation phase that is selected for 

execution is focused in the list. 
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During the execution of a calculation a window appears which gives information about 
the progress of the actual calculation phase (see Figure 3.13). The information, which is 
continuously updated, comprises a load-displacement curve, the level of the load 
systems (in terms of total multipliers) and the progress of the iteration process (iteration 
number, global error, plastic points, etc.). See the Reference Manual for more 
information about the calculations info window. 

When a calculation ends, the list of calculation phases is updated and a message appears 
in the corresponding Log info memo box. The Log info memo box indicates whether or 
not the calculation has finished successfully. The current calculation should give the 
message 'Prescribed ultimate state fully reached'. 

To check the applied load that results in the prescribed displacement of 0.1 m, click the 
Multipliers tab and select the Reached values radio button. In addition to the reached 
values of the multipliers in the two existing columns, additional information is presented 
at the left side of the window. For the current application the value of Force-Y is 
important. This value represents the total reaction force corresponding to the applied 
prescribed vertical displacement, which corresponds to the total force under 1.0 radian 
of the footing (note that the analysis is axisymmetric). In order to obtain the total footing 
force, the value of Force-Y should be multiplied by 2π (this gives a value of about 1100 
kN). 

 
Hint: Calculation phases may be added, inserted or deleted using the Next, Insert 

and Delete buttons half way the Calculations window. 
> Check the list of calculation phases carefully after each execution of a (series 

of) calculation(s). A successful calculation is indicated in the list with a green 
check mark (√) whereas an unsuccessful calculation is indicated with a red 
cross (×). Calculation phases that are selected for execution are indicated by a 
blue arrow (→). 

> When a calculation phase is focused that is indicated by a green check mark 
or a red cross, the toolbar shows the Output button, which gives direct access 
to the Output program. When a calculation phase is focused that is indicated 
by a blue arrow, the toolbar shows the Calculate button. 

 

3.2.3 VIEWING OUTPUT RESULTS 
Once the calculation has been completed, the results can be evaluated in the Output 
program. In the Output window you can view the displacements and stresses in the full 
geometry as well as in cross sections and in structural elements, if applicable.  

The computational results are also available in tabulated form. To view the results of the 
footing analysis, follow these steps: 

• Click the last calculation phase in the Calculations window. In addition, click 
the Output button in the toolbar. As a result, the Output program is started, 
showing the deformed mesh (which is scaled to ensure that the deformations 
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are visible) at the end of the selected calculation phase, with an indication of 
the maximum displacement (see Figure 3.14). 

• Select Total displacements from the Deformations menu. The plot shows the 
total displacements of all nodes as arrows, with an indication of their relative 
magnitude. 

• The presentation combo box in the toolbar currently reads Arrows. Select 
Shadings from this combo box. The plot shows colour shadings of the total 
displacements. An index is presented with the displacement values at the colour 
boundaries. 

• Select Contours from the presentation combo box in the toolbar. The plot 
shows contour lines of the total displacements, which are labelled. An index is 
presented with the displacement values corresponding to the labels.  

 

Figure 3.14  Deformed mesh 

 
Hint: In addition to the total displacements, the Deformations menu allows for the 

presentation of Incremental displacements. The incremental displacements are 
the displacements that occurred within one calculation step (in this case the 
final step). Incremental displacements may be helpful in visualising an 
eventual failure mechanism. 
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• Select Effective stresses from the Stresses menu. The plot shows the effective 
stresses as principal stresses, with an indication of their direction and their 
relative magnitude (see Figure 3.15). 

 
Hint: The plots of stresses and displacements may be combined with geometrical 

features, as available in the Geometry menu. 
 

 

Figure 3.15  Principal stresses 

Click the Table button on the toolbar. A new window is opened in which a 
table is presented, showing the values of the Cartesian stresses in each stress 
point of all elements. 

3.3 CASE B: FLEXIBLE FOOTING 

The project is now modified so that the footing is modelled as a flexible plate. This 
enables the calculation of structural forces in the footing. The geometry used in this 
exercise is the same as the previous one, except that additional elements are used to 
model the footing. The calculation itself is based on the application of load rather than 
prescribed displacements. It is not necessary to create a new model; you can start from 
the previous model, modify it and store it under a different name. To perform this, 
follow these steps: 

Modifying the geometry 
Click the Go to Input button at the left hand side of the toolbar.  

 
• Select the previous file (“lesson1” or whichever name it was given) from the 

Create/Open project window. 
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• Select the Save as option of the File menu. Enter a non-existing name for the 
current project file and click the Save button. 

• Select the geometry line on which the prescribed displacement was applied and 
press the <Del> key on the keyboard. Select Prescribed displacement from the 
Select items to delete window and click the Delete button. 

Click the Plate button in the toolbar. 

 
• Move to position (0.0; 4.0) and click the left mouse button. 

• Move to position (1.0; 4.0) and click the left mouse button, followed by the 
right mouse button to finish the drawing. A plate from point 3 to point 4 is 
created which simulates the flexible footing. 

Modifying the boundary conditions 
Click the Distributed load - load system A button in the toolbar. 

 
• Click point (0.0; 4.0) and then on point (1.0; 4.0). 

• Click the right mouse button to finish the input of distributed loads. Accept the 
default input value of the distributed load (1.0 kN/m2 perpendicular to the 
boundary). The input value will later be changed to the real value when the 
load is activated. 

Adding material properties for the footing 
Click the Material sets button. 

 

• Select Plates from the Set type combo box in the Material Sets window. 

• Click the New button. A new window appears where the properties of the 
footing can be entered. 

• Write “Footing” in the Identification box and select the Elastic material type. 

• Enter the properties as listed in Table 3.2. 

• Click the OK button. The new data set now appears in the tree view of the 
Material Sets window. 

• Drag the set “Footing” to the draw area and drop it on the footing. Note that the 
cursor changes shape to indicate that it is valid to drop the material set. 

• Close the database by clicking the OK button 
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Table 3.2.  Material properties of the footing 

Parameter Name Value Unit 
Normal stiffness 
Flexural rigidity 
Equivalent thickness 
Weight 
Poisson's ratio 

EA 
EI 
d 
w 
ν 

5⋅106

8500 
0.143 
0.0 
0.0 

kN/m 
kNm2/m 
m 
kN/m/m 
- 

 

 
Hint: If the Material Sets window is displayed over the footing and hides it, move 

the window to another position so that the footing is clearly visible. 
 

 
 
Hint: The equivalent thickness is automatically calculated by PLAXIS from the 

values of EA and EI. It cannot be entered by hand. 
 

Generating the mesh 
Click the Mesh generation button to generate the finite element mesh. A 
warning appears, suggesting that the water pressures and initial stresses should 
be regenerated after regenerating the mesh. Click the OK button. 

• After viewing the mesh, click the Update button. 

 
Hint: Regeneration of the mesh results in a redistribution of nodes and stress points. 

In general, existing stresses will not correspond with the new position of the 
stress points. Therefore it is important to regenerate the initial water pressures 
and initial stresses after regeneration of the mesh. 

 

Initial conditions 

 Back in the Geometry input mode, click the Initial conditions button. 

Since the current project does not involve pore pressures, proceed to the 
Geometry configuration mode by clicking the 'switch' in the toolbar. 

Click the Generate initial stresses button, after which the K0 procedure dialog 
box appears. 

• Keep ΣMweight equal to 1.0 and accept the default value of K0 for the single 
cluster. 

• Click the OK button to generate the initial stresses. 

• After viewing the initial stresses, click the Update button. 

• Click the Calculate button and confirm the saving of the current project. 
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Calculations 
• In the General tab sheet, select for the Calculation type: Plastic. 

• Enter an appropriate name for the phase identification and accept 0 - initial 
phase as the phase to start from. 

• In the Parameters tab sheet, select the Staged construction option and click the 
Define button. 

• The plot of the active geometry will appear. Click the load to activate it. A 
Select items dialog box will appear. Activate both the plate and the load by 
checking the check boxes to the left.. 

• While the load is selected click the Change button at the bottom of the dialog 
box. The distributed load – load system A dialog box will appear to set the 
loads. Enter a Y-value of -350 kN/m2 for both geometry points. Note that this 
gives a total load that is approximately equal to the footing force that was 
obtained from the first part of this lesson.  

• (350 kN/m2 x π x (1.0 m)2 ≈ 1100 kN).  

• Close the dialog boxes and click Update. 

Check the nodes and stress points for load-displacement curves to see if the 
proper points are still selected (the mesh has been regenerated so the nodes 
might have changed!). The top left node of the mesh should be selected. 

• Check if the calculation phase is marked for calculation by a blue arrow. If this 
is not the case double-click the calculation phase or right click and select Mark 
calculate from the pop-up menu. Click the Calculate button to start the 
calculation. 

Viewing the results 
• After the calculation the results of the final calculation step can be viewed by 

clicking the Output button. Select the plots that are of interest. The 
displacements and stresses should be similar to those obtained from the first 
part of the exercise. 

• Double-click the footing. A new window opens in which either the 
displacements or the bending moments of the footing may be plotted 
(depending on the type of plot in the first window). 

• Note that the menu has changed. Select the various options from the Forces 
menu to view the forces in the footing. 

 
Hint: Multiple (sub-)windows may be opened at the same time in the Output 

program. All windows appear in the list of the Window menu. PLAXIS follows 
the Windows standard for the presentation of sub-windows (Cascade, Tile, 
Minimize, Maximize, etc). See your Windows manual for a description of 
these standard possibilities. 
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Generating a load-displacement curve 
In addition to the results of the final calculation step it is often useful to view a load-
displacement curve. Therefore the fourth program in the PLAXIS package is used. In 
order to generate the load-displacement curve as given in Figure 3.17, follow these 
steps: 

Click the Go to curves program button on the toolbar. This causes the Curves 
program to start. 

• Select New chart from the Create / Open project dialog box. 

• Select the file name of the latest footing project and click the Open button. 

 

Figure 3.16  Curve generation window 

A Curve generation window now appears, consisting of two columns (x-axis and 
y-axis), with multi select radio buttons and two combo boxes for each column. The 
combination of selections for each axis determines which quantity is plotted along the 
axis. 

• For the X-axis select the Displacement radio button, from the Point combo box 
select A (0.00 / 4.00) and from the Type combo box Uy. Also select the Invert 
sign check box. Hence, the quantity to be plotted on the x-axis is the vertical 
displacement of point A (i.e. the centre of the footing). 

• For the Y-axis select the Multiplier radio button and from the Type combo box 
select ΣMstage. Hence, the quantity to be plotted on the y-axis is the amount of 
the specified changes that has been applied. Hence the value will range from 0 
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to 1, which means that 100% of the prescribed load (350 kN/m2) has been 
applied and the prescribed ultimate state has been fully reached. 

• Click the OK button to accept the input and generate the load-displacement 
curve. As a result the curve of  Figure 3.17 is plotted in the Curves window. 

 
Hint: The Curve settings window may also be used to modify the attributes or 

presentation of a curve. 
 

 

 

Figure 3.17  Load-displacement curve for the footing  

 
Hint: To re-enter the Curve generation window (in the case of a mistake, a desired 

regeneration or modification) you can click the Change curve settings button 
from the toolbar. As a result the Curve settings window appears, on which 
you should click the Regenerate button. Alternatively, you may open the 
Curve settings window by selecting the Curve option from the Format menu. 

> The Frame settings window may be used to modify the settings of the frame. 
This window can be opened by clicking the Change frame settings button 
from the toolbar or selecting the Frame option from the Format menu. 

 

Comparison between Case A and Case B 
When comparing the calculation results obtained from Case A and Case B, it can be 
noticed that the footing in Case B, for the same maximum load of 1100 kN, exhibited 
more deformation than that for Case A. This can be attributed to the fact that in Case B a 
finer mesh was generated due to the presence of a plate element. (By default, PLAXIS 
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generates smaller soil elements at the contact region with a plate element) In general, 
geometries with coarse meshes may not exhibit sufficient flexibility, and hence may 
experience less deformation. The influence of mesh coarseness on the computational 
results is pronounced more in axisymmetric models. If, however, the same mesh was 
used, the two results would match quite well.  
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4 SUBMERGED CONSTRUCTION OF AN EXCAVATION (LESSON 2) 

This lesson illustrates the use of PLAXIS for the analysis of submerged construction of an 
excavation. Most of the program features that were used in Lesson 1 will be utilised here 
again. In addition, some new features will be used, such as the use of interfaces and 
anchor elements, the generation of water pressures and the use of multiple calculation 
phases. The new features will be described in full detail, whereas the features that were 
treated in Lesson 1 will be described in less detail. Therefore it is suggested that Lesson 
1 should be completed before attempting this exercise. 

This lesson concerns the construction of an excavation close to a river. The excavation is 
carried out in order to construct a tunnel by the installation of prefabricated tunnel 
segments. The excavation is 30 m wide and the final depth is 20 m. It extends in 
longitudinal direction for a large distance, so that a plane strain model is applicable. The 
sides of the excavation are supported by 30 m long diaphragm walls, which are braced 
by horizontal struts at an interval of 5.0 m. Along the excavation a surface load is taken 
into account. The load is applied from 2 meter from the diaphragm wall up to 7 meter 
from the wall and has a magnitude of 5 kN/m2/m. 

The upper 20 m of the subsoil consists of soft soil layers, which are modelled as a single 
homogeneous clay layer. Underneath this clay layer there is a stiffer sand layer, which 
extends to a large depth. 

    23                  5   2                   30                    2     5                 23 
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Figure 4.1  Geometry model of the situation of a submerged excavation 

The bottom of the problem to be analysed is taken at 40 m below the ground surface. 
Since the geometry is symmetric, only one half (the left side) is considered in the 
analysis. The excavation process is simulated in three separate excavation stages. The 
diaphragm wall is modelled by means of a plate, such as used for the footing in the 
previous lesson. The interaction between the wall and the soil is modelled at both sides 
by means of interfaces. The interfaces allow for the specification of a reduced wall 
friction compared to the friction in the soil. The strut is modelled as a spring element for 
which the normal stiffness is a required input parameter.  
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For background information on these new objects, see the Reference Manual. 

4.1 GEOMETRY 

To create the geometry model, follow these steps: 

General settings 
• Start the Input program and select New project from the Create / Open project 

dialog box. 

• In the Project tab sheet of the General settings window, enter an appropriate 
title and make sure that Model is set to Plane strain and that Elements is set to 
15-node. 

• In the Dimensions tab sheet, keep the default units (Length = m; Force = kN; 
Time = day) and enter for the horizontal dimensions (Left, Right) 0.0 and 45.0 
respectively and for the vertical dimensions (Bottom, Top) 0.0 and 40.0. Keep 
the default values for the grid spacing (Spacing=1m; Number of intervals = 1). 

• Click the OK button after which the worksheet appears. 

Geometry contour, layers and structures 
The geometry contour: Select the Geometry line button from the toolbar (this 
should, in fact, already be selected for a new project). Move the cursor to the 
origin (0.0; 0.0) and click the left mouse button. Move 45 m to the right (45.0; 
0.0) and click again. Move 40 m up (45.0; 40.0) and click again. Move 45 m to 
the left (0.0; 40.0) and click again. Finally, move back to the origin and click 
again. A cluster is now detected. Click the right mouse button to stop drawing. 

• The separation between the two layers: The Geometry line button is still 
selected. Move the cursor to position (0.0; 20.0). Click the existing vertical 
line. A new point (4) is now introduced. Move 45 m to the right (45.0; 20.0) 
and click the other existing vertical line. Another point (5) is introduced and 
now two clusters are detected. 

The diaphragm wall: Select the Plate button from the toolbar. Move the cursor 
to position (30.0; 40.0) at the upper horizontal line and click. Move 30 m down 
(30.0; 10.0) and click. In addition to the point at the toe of the wall, another 
point is introduced at the intersection with the middle horizontal line (layer 
separation). Click the right mouse button to finish the drawing.  

The separation of excavation stages: Select the Geometry line button again. 
Move the cursor to position (30.0; 38.0) at the wall and click. Move the cursor 
15 m to the right (45.0; 38.0) and click again. Click the right mouse button to 
finish drawing the first excavation stage. Now move the cursor to position 
(30.0; 30.0) and click. Move to (45.0; 30.0) and click again. Click the right 
mouse button to finish drawing the second excavation stage. 
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Hint: Within the geometry input mode it is not strictly necessary to select the 

buttons in the toolbar in the order that they appear from left to right. In this 
case, it is more convenient to create the wall first and then enter the separation 
of the excavation stages by means of a Geometry line. 

> When creating a point very close to a line, the point is usually snapped onto 
the line, because the mesh generator cannot handle non-coincident points and 
lines at a very small distance. This procedure also simplifies the input of 
points that are intended to lie exactly on an existing line. 

> If the pointer is substantially mispositioned and instead of snapping onto an 
existing point or line a new isolated point is created, this point may be 
dragged (and snapped) onto the existing point or line by using the Selection 
button. 

> In general, only one point can exist at a certain coordinate and only one line 
can exist between two points. Coinciding points or lines will automatically be 
reduced to single points or lines. The procedure to drag points onto existing 
points may be used to eliminate redundant points (and lines). 

 
 

The interfaces: Click the Interface button on the toolbar or select the Interface 
option from the Geometry menu. The shape of the cursor will change into a 
cross with an arrow in each quadrant. The arrows indicate the side at which the 
interface will be generated when the cursor is moved in a certain direction. 

• Move the cursor (the centre of the cross defines the cursor position) to the top 
of the wall (30.0; 40.0) and click the left mouse button. Move to the bottom of 
the wall (30.0; 10.0) and click again. According to the position of the 'down' 
arrow at the cursor, an interface is generated at the left hand side of the wall. 
Similarly, the 'up' arrow is positioned at the right side of the cursor, so when 
moving up to the top of the wall and clicking again, an interface is generated at 
the right hand side of the wall. Move back to (30.0; 40.0) and click again. Click 
the right mouse button to finish drawing. 

 
Hint: The selection of an interface is done by selecting the corresponding geometry 

line and subsequently selecting the corresponding interface (positive or 
negative) from the Select dialog box. 

 
 

 
Hint: Interfaces are indicated as dotted lines along a geometry line. In order to 

identify interfaces at either side of a geometry line, a positive sign (⊕) or 
negative sign ( ) is added. This sign has no physical relevance or influence 
on the results. 

 

The strut: Click the Fixed-end anchor button on the toolbar or select the Fixed-
end anchor option from the Geometry menu. Move the cursor to a position 1 
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metre below point 6 (30.0; 39.0) and click the left mouse button. A properties 
window appears in which the orientation angle and the equivalent length of the 
anchor can be entered. Enter an Equivalent length of 15 m (half the width of 
the excavation) and click the OK button (the orientation angle remains 0°). 

 
Hint: A fixed-end anchor is represented by a rotated T with a fixed size. This object 

is actually a spring of which one end is connected to the mesh and the other 
end is fixed. The orientation angle and the equivalent length of the anchor 
must be directly entered in the properties window. The equivalent length is 
the distance between the connection point and the position in the direction of 
the anchor rod where the displacement is zero. By default, the equivalent 
length is 1.0 unit and the angle is zero degrees (i.e. the anchor points in the 
positive x-direction). 

> Clicking the 'middle bar' of the corresponding T selects an existing fixed-end 
anchor. 

 

The surface load: Click the Distributed load – load system A. Move the cursor 
to (23.0; 40.0) and click. Move the cursor 5 m to the right to (28.0; 40.0) and 
click again. Right click to finish drawing. Click the Selection tool and double-
click the distributed load and select Distributed Load (System A) from the list. 
Enter Y-values of –5 kN/m2. 

Boundary Conditions 
To create the boundary conditions, click the Standard fixities button on the 
toolbar. As a result, the program will generate full fixities at the bottom and 
vertical rollers at the vertical sides. These boundary conditions are in this case 
appropriate to model the conditions of symmetry at the right hand boundary 
(center line of the excavation). The geometry model so far is shown in Figure 
4.2. 

 

Figure 4.2  Geometry model in the Input window  
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Material properties 
After the input of boundary conditions, the material properties of the soil clusters and 
other geometry objects are entered in data sets. Interface properties are included in the 
data sets for soil (Data sets for Soil & interfaces). Two data sets need to be created; one 
for the clay layer and one for the sand layer. In addition, a data set of the Plate type is 
created for the diaphragm wall and a data set of the Anchor type is created for the strut. 
To create the material data sets, follow these steps: 

Click the Material sets button on the toolbar. Select Soil & interfaces as the Set 
type. Click the New button to create a new data set. 

• For the clay layer, enter 'Clay' for the Identification and select Mohr-Coulomb 
as the Material model. Since only long-term effects of the excavation are 
considered here, we will not take into account the undrained behaviour. Hence, 
the material type is set to Drained. 

• Enter the properties of the clay layer, as listed Table 4.1, in the corresponding 
edit boxes of the General and Parameters tab sheet. 

Click the Interfaces tab. In the Strength box, select the Manual radio button. 
Enter a value of 0.5 for the parameter Rinter. This parameter relates the strength 
of the soil to the strength in the interfaces, according to the equations: 
tan ϕinterface = Rinter tan ϕsoil       and          cinter = Rinter csoil

where:  
csoil = cref  (see Table 4.1) 
Hence, using the entered Rinter-value gives a reduced interface friction and  
interface cohesion (adhesion) compared to the friction angle and the cohesion 
in the adjacent soil. 

Table 4.1.  Material properties of the sand and clay layer and the interfaces 
Parameter Name Clay 

layer 
Sand 
layer 

Unit 

Material model 
 
Type of material behaviour 
Soil unit weight above phreatic level 
Soil unit weight below phreatic level 
Permeability in hor. direction 
Permeability in ver. direction 
Young's modulus (constant) 
Poisson's ratio 
Cohesion (constant) 
Friction angle 
Dilatancy angle 
Strength reduction factor inter. 

Model 
 
Type 
γunsat

γsat

kx

ky

Eref

ν 
cref

ϕ 
ψ 
Rinter

Mohr-
Coulomb 
Drained 
16 
18 
0.001 
0.001 
10000 
0.35 
5.0 
25 
0.0 
0.5 

Mohr-
Coulomb 
Drained 
17 
20 
1.0 
1.0 
40000 
0.3 
1.0 
32 
2.0 
0.67 

- 
 
- 
kN/m3

kN/m3

m/day 
m/day 
kN/m2

- 
kN/m2

° 
° 
- 
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• For the sand layer, enter 'Sand' for the Identification and select Mohr-Coulomb 
as the Material model. The material type should be set to Drained. 

• Enter the properties of the sand layer, as listed Table 4.1, in the corresponding 
edit boxes of the General and Parameters tab sheet. 

• Click the Interfaces tab. In the Strength box, select the Manual radio button. 
Enter a value of 0.67 for the parameter Rinter. Close the data set. 

• Drag the 'Sand' data set to the lower cluster of the geometry and drop it there. 
Assign the 'Clay' data set to the remaining four clusters (in the upper 20 m). By 
default, interfaces are automatically assigned the data set of the adjacent 
cluster. 

 
Hint: Instead of accepting the default data sets of interfaces, data sets can directly 

be assigned to interfaces in their properties window. This window appears 
after double-clicking the corresponding geometry line and selecting the 
appropriate interface from the Select dialog box.  On clicking the Change 
button behind the Material set parameter, the proper data set can be selected 
from the Material sets tree view. 

 
 

 
Hint: In addition to the Material set parameter in the properties window, the Virtual 

thickness factor can be entered. This is a purely numerical value, which can 
be used to optimise the numerical performance of the interface. Non-
experienced users are advised not to change the default value. For more 
information about interface properties see the Reference Manual. 

 

• Set the Set type parameter in the Material sets window to Plates and click the 
New button. Enter “Diaphragm wall” as an Identification of the data set and 
enter the properties as given in Table 4.2. Click the OK button to close the data 
set. 

• Drag the Diaphragm wall data set to the wall in the geometry and drop it as 
soon as the cursor indicates that dropping is possible.  

Table 4.2.  Material properties of the diaphragm wall (Plate) 

Parameter Name Value Unit 
Type of behaviour 
Normal stiffness 
Flexural rigidity 
Equivalent thickness 
Weight 
Poisson's ratio 

Material type 
EA 
EI 
d 
w 
ν 

Elastic 
7.5⋅106

1.0⋅106

1.265 
10.0 
0.0 

 
kN/m 
kNm2/m 
m 
kN/m/m 
- 
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Hint: The radio button Rigid in the Strength box is a direct option for an interface 

with the same strength properties as the soil (Rinter = 1.0). 
 

• Set the Set type parameter in the Material sets window to Anchors and click the 
New button. Enter “Strut” as an Identification of the data set and enter the 
properties as given in Table 4.3. Click the OK button to close the data set. 

• Drag the Strut data set to the anchor in the geometry and drop it as soon as the 
cursor indicates that dropping is possible. Close the Material sets window. 

Table 4.3.  Material properties of the strut (anchor) 

Parameter Name Value Unit 
Type of behaviour 
Normal stiffness 
Spacing out of plane 
Maximum force 

Material type 
EA 
Ls

Fmax,comp 

Fmax,tens

Elastic 
2⋅106

5.0 
1⋅1015 

1⋅1015

 
kN 
m 
kN 
kN 

Mesh Generation  
In this lesson some simple mesh refinement procedures are used. In addition to a direct 
global mesh refinement, there are simple possibilities for local refinement within a 
cluster, on a line or around a point. These options are available from the Mesh menu. In 
order to generate the proposed mesh, follow these steps: 

Click the Generate mesh button in the toolbar. A few seconds later, a coarse 
mesh is presented in the Output window. Click the Update button to return to 
the geometry input. 

• From the Mesh menu, select the Global coarseness option. The Element 
distribution combo box is set to Coarse, which is the default setting. In order to 
refine the global coarseness, one could select the next item from the combo box 
(Medium) and click the Generate button. Alternatively, the Refine global 
option from the Mesh menu could be selected. As a result, a finer mesh is 
presented in the Output window. Click the Update button to return. 

• Corner points of structural elements may cause large displacement gradients. 
Hence, it is good to make those areas finer than other parts of the geometry. 
Click in the middle of the lowest part of the wall (single click). The selected 
geometry line is now indicated in red. From the Mesh menu, select the option 
Refine line. As a result, a local refinement of the indicated line is visible in the 
presented mesh. Click the Update button to return. 

 
Hint: The Reset all option in the Mesh menu is used to restore the mesh generation 

default setting (Global coarseness = Coarse and no local refinement). 
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Hint: The mesh settings are stored together with the rest of the input. On re-entering 

an existing project and not changing the geometry configuration and mesh 
settings, the same mesh can be regenerated by just clicking the Generate mesh 
button on the toolbar. However, any slight change of the geometry will result 
in a different mesh. 

 

Initial conditions 
The initial conditions of the current project require the generation of water pressures, the 
deactivation of structures and loads and the generation of initial stresses. Water 
pressures (pore pressures and water pressures on external boundaries) can be generated 
in two different ways: A direct generation based on the input of phreatic levels and 
groundwater heads or an indirect generation based on the results of a groundwater flow 
calculation. The current lesson only deals with the direct generation procedure.  
Generation based on groundwater flow is presented in the second part of the Lesson 4 
(see Section 6.2). 

Within the direct generation option there are several ways to prescribe the water 
conditions. The simplest way is to define a general phreatic level, under which the water 
pressure distribution is hydrostatic, based on the input of a unit water weight. The 
general phreatic level is automatically assigned to all clusters for the generation of pore 
pressures. It is also used to generate external water pressures, if applicable. Instead of 
the general phreatic level, individual clusters may have a separate phreatic level or an 
interpolated pore pressure distribution. The latter advanced options will be demonstrated 
in the first part of Lesson 3 (see Section 5.2). Here only a general phreatic level is 
defined at 2.0 m below the ground surface.  

In order to generate the proper initial pore pressures, follow these steps: 

Click the Initial conditions button on the toolbar. 

 
Hint: When a project is newly created, the water weight is presented directly on 

entering the Groundwater mode. On re-entering an existing project the input 
of the water weight can be accessed by selecting the Water weight option 
from the Geometry menu in the Groundwater mode. 

 

Click OK to accept the default value of the unit weight of water, which is 10 
kN/m3. The Groundwater conditions mode then becomes active, in which the 
Phreatic level button is already selected. By default, a General phreatic level is 
generated at the bottom of the geometry. 

• Move the cursor to position (0.0; 38.0) and click the left mouse button. Move 
45 m to the right (45.0; 38.0) and click again. Click the right mouse button to 
finish drawing. The plot now indicates a new General phreatic level 2.0 m 
below the ground surface. 
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Hint: An existing phreatic level may be modified using the Selection button from 

the toolbar. On deleting the General phreatic level (selecting it and pressing 
the <Del> key on the keyboard), the default general phreatic level will be 
created again at the bottom of the geometry. The graphical input or 
modification of phreatic levels does not affect the existing geometry. 

> To create an accurate pore pressure distribution in the geometry, an additional 
geometry line can be included corresponding with the level of the 
groundwater head or the position of the phreatic level in a problem. 

 

Click the Generate water pressures button (blue crosses) on the toolbar. Now 
the Water pressure generation window appears. 

• From the Water pressure generation window, select the Phreatic level radio 
button in the Generate by box and click the OK button. 

• After generating the water pressures, the result is displayed in the Output 
window. Click the Update button to return to Groundwater conditions mode. 

After the generation of water pressures and before the generation of initial effective 
stresses, parts of the geometry that are not active in the initial state must be deactivated. 
This option is used initially to deactivate geometry parts (clusters or structural objects) 
that are to be constructed at later calculation stages. PLAXIS will automatically 
deactivate loads and structural elements in the initial geometry configuration. 

In the current project, the diaphragm wall and the anchor are initially not present and 
should be inactivate for the initial geometry. The K0 procedure for the generation of 
initial stresses will not take into account the inactivate geometry clusters. 

Proceed to Geometry configuration mode by clicking the 'switch' in the toolbar. 

• Check that the wall and the strut in the geometry are inactive. Inactive elements 
are coloured grey. Make sure that all soil clusters remain active. 

 
Hint: Inactive clusters are white, just like the background, whereas active clusters 

have the colour of the corresponding material set. Inactive structural objects 
are grey, whereas active structures have the basic colour as used during the 
creation of the geometry model. 

 

Click the Generate initial stresses button in the toolbar. The K0 procedure 
dialog box appears. 

• Keep the total multiplier for soil weight equal to 1.0. Accept the default values 
for K0 and click the OK button. 

• After the generation of the initial effective stresses, the result is displayed in the 
Output window. Click the Update button to return to the Initial configuration 
mode. 

• Click the Calculate button. Select Yes in response to the question about saving 
the data and enter an appropriate file name. 
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4.2 CALCULATIONS 

In practice, the construction of an excavation is a process that can consist of several 
phases. First, the wall is installed to the desired depth. Then some excavation is carried 
out to create space to install an anchor or a strut. Then the soil is gradually removed to 
the final depth of the excavation. Special measures are usually taken to keep the water 
out of the excavation. Props may also be provided to support the retaining wall. 

In PLAXIS, these processes can be simulated with the Staged construction calculation 
option. Staged construction enables the activation or deactivation of weight, stiffness 
and strength of selected components of the finite element model. The current lesson 
explains the use of this powerful calculation option for the simulation of excavations. 

 
Hint: The Staged construction option is not only intended to simulate excavations 

or constructions, but it can also be used to change the water pressure 
distribution, to change material properties (to simulate soil improvement, for 
example) or to improve the accuracy of previous computational results. 

 

The excavation, as considered in this example, is to be carried out in five phases. The 
separation of the three excavation phases was taken into account during the creation of 
the geometry model by introducing geometry lines in the appropriate positions. In order 
to define the five calculation phases, follow these steps: 

Phase 1: External load 
• In addition to the initial phase, the first calculation phase has also been 

automatically created. In the General tab sheet, accept all defaults. 
• In the Parameters tab sheet, keep the default values for Control parameters and 

Iterative procedure. Select Staged construction from the Loading input box. 
• Click the Define button. The Staged construction window now appears, 

showing the currently active part of the geometry, which is the full geometry 
except for the wall, strut and load.  

• Click the wall to activate it (the wall should become blue). In addition, click the 
load to activate it. The load has been defined in Input as –5 kN/m2. You can 
check this by double clicking the load. 

 
Hint: You can also enter or change the values of the load at this time by double-

clicking the load and entering a value. If a load is applied on a structural 
object such as a plate, load values can be changed by clicking the load or the 
object. As a result a window appears in which you can select the load. Then 
click the Change button to modify the load values.  

 

• Click the Update button to finish the definition of the construction phase. As a 
result, the Staged construction window is closed and the Calculations window 
reappears. The first calculation phase has now been defined and saved. 
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Phase 2: First excavation stage 
• Within the Calculations window, click the Next button. A new calculation 

phase appears in the list. 

• Note that the program automatically presumes that the current phase should 
start from the previous one. 

• In the General tab sheet, accept all defaults. Enter the Parameters tab sheet and 
click the Define button to define the next Staged construction step. The staged 
construction window now reappears. The load and the wall should be active 
and marked as blue elements.  

• Click the top right cluster in order to deactivate it and simulate the first 
excavation step. 

• Click the Update button to finish the definition of the first excavation phase. 

Phase 3: Installation of strut 
• To enter the third calculation phase, click Next and proceed as described above. 

Again click Define to enter the Staged construction window. Now activate the 
strut by clicking the horizontal line. The strut should turn black to indicate it is 
active. 

• Click Update to return to the calculation program and define another 
calculation phase. 

Phase 4: Second (submerged) excavation stage 
• Keep all default settings and enter the Staged construction window. This phase 

will simulate the excavation of the second part of the building pit. Deactivate 
the second cluster from the top on the right side of the mesh. It should be the 
topmost active cluster. Go to Update and define the final stage. 

 
Hint: Note that in PLAXIS the pore pressures are not automatically deactivated when 

deactivating a soil cluster. Hence, in this case, the water remains in the 
excavated area and a submerged excavation is simulated. 

 

Phase 5: Third excavation stage 
• The final calculation stage is to simulate the excavation of the last clay layer 

inside the pit. Deactivate the third cluster from the top on the right hand side of 
the mesh. Click Update to return to the Calculations window. 

The calculation definition is now complete. Before starting the calculation it is 
suggested that you select nodes or stress points for a later generation of load-
displacement curves or stress and strain diagrams. To do this, follow the steps given 
below. 
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• Click the Select points for curves button on the toolbar. 

• Select some nodes on the wall at points where large deflections can be expected 
(e.g. 30.0;30.0) and click the Update button. 

 
Hint: To select the desired nodes, it may be convenient to use the Zoom in option on 

the toolbar to zoom into the area of interest. 
 

 
• In the Calculations window, click the Calculate button. 

 

Figure 4.3  The Calculations window with the Parameters tab sheet 

The calculation process should now start. The program searches for the first calculation 
phase that is selected for execution, which is <Phase 1>.  

During a Staged construction calculation, a multiplier called ΣMstage is increased from 
0.0 to 1.0. This parameter is displayed on the calculation info window. As soon as 
ΣMstage has reached the value 1.0, the construction stage is completed and the 
calculation phase is finished. If a Staged construction calculation finishes while 
ΣMstage is smaller than 1.0, the program will give a warning message. The most likely 
reason for not finishing a construction stage is that a failure mechanism has occurred, 
but there can be other causes as well. See the Reference Manual for more information 
about Staged construction. 

In this example, all calculation phases should successfully finish, which is indicated by 
the green check boxes in the list. In order to check the values of the ΣMstage multiplier, 
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click the Multipliers tab and select the Reached values radio button. The ΣMstage 
parameter is displayed at the bottom of the Other box that pops up. Verify that this value 
is equal to 1.0. You also might wish to do the same for the other calculation phase. 

 
Hint: The Staged construction window is similar to the Initial conditions window of 

the Input program. The main difference is that Initial conditions is used to 
create an initial situation, whereas Staged construction is used as a type of 
loading. 

 

4.3 VIEWING OUTPUT RESULTS 

In addition to the displacements and the stresses in the soil, the Output program can be 
used to view the forces in structural objects. To examine the results of this project, 
follow these steps: 

• Click the final calculation phase in the Calculations window. 

• Click the Output button on the toolbar. As a result, the Output program is 
started, showing the deformed mesh (scaled up) at the end of the selected 
calculation phase, with an indication of the maximum displacement (Figure 
4.4). The loads shown inside the excavation represent the remaining water 
pressures. 

 

Figure 4.4  Deformed mesh after submerged excavation 
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• Select Total increments from the Deformations menu. The plot shows the  
displacement increments of all nodes as arrows. The length of the arrows 
indicates the relative magnitude. 

• The presentation combo box in the toolbar currently reads Arrows. Select 
Shadings from this combo box. The plot should now show colour shadings of 
the displacement increments. From this plot a zone of intense shearing is 
visible behind the wall. 

• Select Effective stresses from the Stresses menu. The plot shows the magnitude 
and direction of the principal effective stresses. The orientation of the principal 
stresses indicates a large passive zone under the bottom of the excavation and a 
small passive zone behind the strut (see Figure 4.5). 

 
Figure 4.5  Principal stresses after excavation 

To plot the shear forces and bending moments in the wall follow the steps given below. 

• Double-click the wall. A new window is opened showing the bending moments 
in the wall, with an indication of the maximum moment (see Figure 4.6). Note 
that the menu has changed. 
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Figure 4.6  Bending moments in the wall 

• Select Shear forces from the Forces menu. The plot now shows the shear 
forces in the wall. 

 
Hint: The Window menu may be used to switch between the window with the forces 

in the wall and the stresses in the full geometry. This menu may also be used 
to Tile or Cascade the two windows, which is a common option in a Windows 
environment. 

 

• Select the first window (showing the effective stresses in the full geometry) 
from the Window menu. Double-click the strut. A new window is now opened 
showing the strut force in kN/m. This value must be multiplied by the out of 
plane spacing of the struts to calculate the individual strut forces (in kN). 

• Click the Go to curves program button on the toolbar. As a result, the load-
displacement curves program is started. 

• Select New chart from the Create / Open project dialog box and select the file 
name of the excavation project from the file requester. 

• In the Curve generation window, select for the X-axis the Displacement radio 
button and point A (e.g. 30.0;30.0) and from the Type combo box select the 
item |U|. Select for the Y-axis the Multiplier radio button and from the Type 
combo box ΣMstage. 

• Click the OK button to accept the input and generate the load-displacement 
curve. As a result the curve of Figure 4.7 is plotted. 
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Figure 4.7  Load-displacement curve of deflection of wall 

The curve shows the construction stages. For each stage, the parameter ΣMstage 
changes from 0.0 to 1.0. The decreasing slope the curve of the last stage indicates that 
the amount of plastic deformation is increasing. The results of the calculation indicate, 
however, that the excavation remains stable at the end of construction. 
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5 UNDRAINED RIVER EMBANKMENT (LESSON 3) 

River embankments may be subjected to varying water levels. The change in water level 
and the resulting change in the pore pressure distribution influences the stability of the 
embankment. PLAXIS may be used to analyse the influence of pore pressure changes on 
the deformation and stability of geotechnical structures. This feature is used here to 
study the behaviour of the river embankment during the increase of the water level, as 
shown in Figure 5.1. A special problem related to such a situation is the possible uplift 
of the lowlands behind the embankment. This is due to the fact that the light soft soil 
layers cannot sustain the high pore pressures that arise in the permeable sand layer 
below. This effect may reduce the stability of the embankment. 

The embankment in Figure 5.1 is 5 m high and consists of relative impervious clay. The 
upper 6 m of the subsoil consists of soft soil layers, of which the top 3 m is modelled as 
a clay layer and the lower 3 m as a peat layer. The soft soil layers are nearly 
impermeable, so a short-term variation in the river water level hardly influences the pore 
pressure distribution in these layers. Below the soft soil layers there is a deep permeable 
sand layer, of which the upper 4 m are included in the finite element model. It is 
assumed that the water in the sand layer is in contact with the river, which means that 
the hydraulic head in the sand layer follows the river water level variation closely. 

 

 

Figure 5.1  Geometry of the river embankment subjected to a changing water level 

5.1 GEOMETRY MODEL 

The geometry of Figure 5.1 is modelled with a plane strain geometry model. The finite 
element mesh is based on the 15-node elements. The units used in this example are 
meters for length, kiloNewton for force and day for time. The dimensions of the 
geometry are 65 m in horizontal direction and 15 m in vertical direction. The full 
geometry can be created using the Geometry line option. The Standard fixities option is 
used to define the boundary conditions. The suggested geometry model is shown in 
Figure 5.2. 
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Figure 5.2  Geometry model of the river embankment project 

Material sets 
Three material layers are adopted for the soil. The properties are given in Table 5.1. 

Table 5.1.  Material properties of the river embankment and subsoil 

Parameter Name Clay Peat Sand Unit 
Material model 
Type of behaviour 
Soil unit weight above  p.l. 
Soil unit weight below p.l. 
Horizontal permeability 
Vertical permeability 
Young's modulus  
Poisson's ratio 
Cohesion 
Friction angle 
Dilatancy angle 

Model 
Type 
γunsat 

γsat 

kx

ky

Eref

ν 
cref

ϕ 
ψ 

MC 
Undr. 
16 
18 
0.001 
0.001 
2000 
0.35 
2.0 
24 
0.0 

MC 
Undr. 
8 
11.5 
0.01 
0.001 
500 
0.35 
7.0 
20 
0.0 

MC 
Drained 
17 
20 
1.0 
1.0 
20000 
0.3 
1.0 
35 
0.0 

- 
- 
kN/m3

kN/m3

m/day 
m/day 
kN/m2

- 
kN/m2

° 
° 

 
Open the material data base and create three data sets named 'Clay', 'Peat' and 'Sand' 
with the model parameters as listed above. The interface properties are not relevant in 
this example. Note that the Material type of the clay and peat layers is Undrained, 
whereas the sand layer is Drained. Drag the data sets to the respective layers in the 
geometry model (see Figure 5.1). 
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Mesh generation 
This example, in which an uplift situation is modelled, is sensitive to the degree of 
refinement of the mesh. Therefore the Global coarseness is set to Medium in the Mesh 
menu. In addition, larger displacement gradients may be expected at the right hand 
embankment toe. In order to model that part of the geometry more accurately, select the 
geometry point of the embankment toe and select Refine around point from the Mesh 
menu. As a result, the element size around the embankment toe is modified to half the 
average element size. The generated mesh is shown in Figure 5.3. 

 

Figure 5.3  Finite element mesh of river embankment project 

Initial conditions 
The geometry contains a non-horizontal soil surface. Therefore the K0 procedure 
cannot be used to calculate the initial stress field. Instead the initial stresses must be 
calculated by means of 'Gravity loading'. This is a calculation option that will be 
explained in Section 5.2. The activation of water pressures is always done together with 
the soil weight, but the generation of water pressures may be done in advance. In order 
to generate the proper initial water pressures, follow these steps: 

• Click the Initial conditions button. 

• Accept the default value of the water weight (10 kN/m3). 

• Enter a general phreatic level from point (0.0; 10.0) to point (65.0; 10.0). 

• Generate the pore pressures from the phreatic level by clicking the Generate 
water pressures button and subsequently clicking the OK button. 

• In the Output window, check the pore pressure distribution and click the 
Update button. 

• Back in the Input window, click directly on the Calculate button. Do not 
generate the initial stresses according to the K0 procedure. 

• Save the input under an appropriate name. 

 
Hint: If initial stresses were generated by mistake, they can be reset by entering the 

K0 procedure, entering a value of ΣMweight = 0 and pressing the Generate 
button. 
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5.2 CALCULATIONS 

The calculation consists of two phases. First the initial stress field has to be calculated 
since this has not been done during the input of the initial conditions. The calculation of 
the initial stresses can be done in a plastic calculation where the multiplier for the soil 
weight is increased from 0.0 to 1.0. A calculation of this sort is called Gravity loading. 
This procedure is recommended when the soil surface, the layering or the phreatic level 
is non-horizontal. Gravity loading always results in an equilibrium stress state, whereas 
the K0 procedure does not in the case of a non-horizontally layered subsoil. During 
Gravity loading both the soil weight and the pore pressures (that were generated 
previously) are activated. 

 
Hint: Since the initial stresses are not subject to undrained behaviour, it is important 

that undrained behaviour is disabled during gravity loading. This can be done 
by selecting Ignore undrained behaviour in the Parameters tab sheet of the 
Calculations window. 

> In contrast to the K0 procedure, the calculation of initial stresses by means of 
gravity loading results in displacements. These displacements are not realistic, 
because the embankment is modelled as it appears in reality and the 
calculation of the initial stresses should not influence the displacements 
computed later in the analysis. These unrealistic displacements can be reset to 
zero at the start of the next calculation phase by selecting Reset displacements 
to zero in the next phase. 

 

The second calculation phase is the increase of the river water level, and the pore 
pressure, in the sand layer. This is done in the Staged construction mode. In order to 
define the two calculation phases correctly, follow this procedure: 

Phase 1: Gravity loading 
• For the first calculation phase, accept all default values of the General tab sheet 

and advance to the next tab sheet. 

• In the Parameters tab sheet, select Ignore undrained behaviour in the Control 
parameters box. Select Total multipliers in the Loading input box and click the 
Define button. 

• In the Multipliers tab sheet, enter a value of 1.0 for ΣMweight (the multiplier 
for the soil weight). 

Phase 2: Raising the water level 
• Click the Next button to create the next calculation phase. In this phase the 

'Ultimate' situation as indicated in Figure 5.1 will be defined. 

• In the General tab sheet, accept all default values. The default setting is such 
that the current phase starts from the results obtained from the previous phase. 
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• In the Parameters tab sheet, select Reset displacements to zero in the Control 
parameters box. This will eliminate the non-physical displacements resulting 
from the first calculation phase. This operation, however, does not affect the 
stresses. 

• Select Staged construction in the Loading input box and click the Define 
button. 

• In the Geometry configuration window, click the left button of the 'Switch' to 
arrive in the water pressure mode.  

• Enter a general phreatic level through the points (0.0; 15.0), (20.0; 15.0), (45.0; 
10.0). This general phreatic level is only meant to generate the external water 
pressures on the left side of the embankment (see also Figure 5.4). Individual 
water conditions will now be assigned to the different layers.  

 
Figure 5.4  General phreatic level for generation of external water pressures 

• Click the Selection button and select the cluster of the clay layer (including the 
embankment). 

• While the clay layer cluster is marked, click the Phreatic level button and draw 
a phreatic level through the points (0.0; 10.0), (65.0; 10.0). This 'Cluster 
defined' phreatic level only applies to the indicated cluster (see Figure 5.5). 
Figure 5.5 has been edited to only show the phreatic level for the clay layer. 
The general phreatic level is not indicated.  

 
Figure 5.5  Phreatic level for clay layer 

• Click the Selection button and select the cluster of the sand layer. 

• While the sand layer is marked, click the Phreatic level button and draw a 
phreatic level through the points (0.0; 15.0), (65.0; 13.0). This phreatic level 
only applies to the sand layer cluster. Figure 5.6 only shows the phreatic level 
for the sand layer; other phreatic levels are not indicated. 
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Figure 5.6  Phreatic level for sand layer 

• Click the Selection button and double-click, or click using the right mouse 
button, the intermediate peat layer. As a result, a Cluster Pore pressures 
distribution window appears. In the Pore pressure distribution box, there are 
five radio buttons. By default the General phreatic level is selected. The other 
options are Cluster phreatic level, Interpolate from adjacent clusters or lines, 
Cluster dry and User defined pore pressure distribution. The Cluster phreatic 
level option is automatically selected if a separate phreatic level is entered, as 
described above. For the current cluster (the peat layer) you should select the 
option Interpolate from adjacent clusters or lines (see also Figure 5.7). This 
will result in a linear distribution from the pressure at the bottom of the upper 
clay layer to the pressure at the top of the sand layer. Click the OK button to 
close the window. 

 

Figure 5.7  Definition of pore pressures for peat layer  
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Hint: The phreatic level corresponding to a particular cluster is indicated in red as 

soon as the cluster is selected. Clicking outside the geometry results in an 
indication of the general phreatic level. If a cluster is selected where the 
Interpolate... option applies, no phreatic level is indicated. 

 

• Click the Generate water pressures button to generate the water pressures 
according to the ultimate situation. 

• The pore pressure distribution is presented as principal stresses (by means of 
crosses) in the Output window. Click the Cross section button and draw a 
vertical line through the top of the embankment to the bottom of the geometry. 
As a result, the pore pressure distribution over all three layers is displayed in a 
separate window. In addition to the hydrostatic part of the pore pressure 
distribution in the clay and sand layers, the plot shows the linear increase in 
pore pressure through the peat layer. 

 
Hint: A cross section can be drawn perfectly horizontal or vertical by holding down 

the <Shift> key while drawing the cross section. 
 

• Click the Update button to return to the geometry configuration. 

• In the geometry configuration, click the Update button to return to the 
Calculations window. 

• Click the Select points for curves button. In the Output window, select suitable 
points for load-displacement curves (for example the toe and crest points of the 
embankment) and click the Update button. 

• In the Calculations window, click the Calculate button to start the calculations. 

5.3 OUTPUT 

After the calculation has finished, click the Output button to view the results of the 
second calculation phase. The Output program will now display the deformations of the 
embankment due to the change of the water level. The plot clearly shows the uplift of 
the soft soil layers behind the embankment and the movement of the embankment itself. 
This becomes even clearer if you select Total increments from the Deformations menu 
(see Figure 5.8). 

 
Figure 5.8  Displacement increments due to the change in water level 
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On selecting Effective stresses from the Stresses menu, it can be seen that at the top of 
the sand layer at the right hand side of the model the effective stresses are nearly zero 
(see Figure 5.9). This is due to the increase in pore pressures in the sand layer. From the 
stress plot it can also be seen that the movement of the embankment causes a passive 
stress state in the clay layer behind the embankment. 

 
Figure 5.9  Effective stresses in embankment after the increase of the water level 

The undrained behaviour in the clay and peat layers causes excess pore pressures to 
develop. The excess pore pressures can be viewed by selecting Excess pore pressures 
from the Stresses menu (see Figure 5.10). 

 
Figure 5.10  Excess pore pressures after the increase of the water level 
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6 DRY EXCAVATION USING A TIE BACK WALL (LESSON 4) 

This example involves the dry construction of an excavation. The excavation is 
supported by concrete diaphragm walls. The walls are tied back by pre-stressed ground 
anchors.  

PLAXIS allows for a detailed modelling of this type of problem. It is demonstrated in this 
example how ground anchors are modelled and how pre-stressing is applied to the 
anchors. Moreover, the dry excavation involves a groundwater flow calculation to 
generate the new water pressure distribution. This aspect of the analysis is explained in 
detail. 

6.1 INPUT 

The excavation is 20 m wide and 10 m deep. 15 m long concrete diaphragm walls of 
0.35 m thickness are used to retain the surrounding soil. Two rows of ground anchors 
are used at each wall to support the walls. The upper anchor has a total length of 14.5 m 
and an inclination of 33.7° (2:3). The lower anchor is 10 m long and is installed at an 
angle of 45°. On the left side of the excavation a surface load of 10 kN/m2 is taken into 
account and on the right side a surface load of 5 kN/m2.  

10         2             20                  2     5   

5 kPa 10 kPa
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Figure 6.1  Excavation supported by tie back walls 

The relevant part of the soil consists of three distinct layers. From the ground surface to 
a depth of 3 m there is a fill of relatively loose fine sandy soil. Underneath the fill, down 
to a minimum depth of 15 m, there is a more or less homogeneous layer consisting of 
dense well-graded sand. This layer is particular suitable for the installation of the ground 
anchors.  

In the initial situation there is a horizontal phreatic level at 3 m below the ground surface 
(i.e. at the base of the fill layer). Below the sand layer there is a loam layer, which 
extends to large depth.  

loam 

sand 

fill 

ground 
anchor 

3  

7 

 

5 
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Geometry model 
The problem can be modelled with a geometry model of 80 m width and 20 m 
height. The proposed geometry model is given in Figure 6.2. A ground anchor 
can be modelled by a combination of a node-to-node anchor and a geogrid 
(yellow line). The geogrid simulates the grout body whereas the node-to-node 
anchor simulates the anchor rod. In reality there is a complex three-dimensional 
state of stress around the grout body.  

Although the precise stress state and interaction with the soil cannot be modelled with 
this 2D model, it is possible in this way to estimate the stress distribution, the 
deformations and the stability of the structure on a global level, assuming that the grout 
body does not slip relative to the soil. With this model it is certainly not possible to 
evaluate the pullout force of the ground anchor. 

The diaphragm walls are modelled as plates. The interfaces around the plates are used to 
model soil-structure interaction effects. They are extended under the wall for 1.0 m. 
Interfaces should not be used around the geogrid that represent the grout body. 

 
Hint: In general, it is a good habit to extend interfaces around corners of structures 

to allow for sufficient freedom of deformation and to obtain a more accurate 
stress distribution. When doing so, make sure that the strength of the extended 
part of the interface is equal to the soil strength and that the interface does not 
influence the flow field, if applicable. The latter can be achieved by switching 
off the extended part of the interface before performing a groundwater flow 
analysis. 

 

The excavation is constructed in three excavation stages. The separation between the 
stages is modelled by geometry lines. Create the basic geometry model as presented in 
Figure 6.2. The standard fixities can be used to generate the proper boundary conditions. 

18                         10       2                20                 2    5                    23 
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Figure 6.2  Geometry model of building pit 
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Material properties 
The soil consists of three distinct layers. Enter three data sets for soil & interfaces with 
the parameters given in Table 6.1.  

 
Hint: The extended part of an interface is not used for soil-structure interaction and 

should therefore have the same strength as the surrounding soil. This can be 
achieved with a strength reduction factor Rinter = 1.0, which is automatically 
adopted in the Rigid selection. If necessary, a separate material data set must 
be created for the extended part of an interface. In addition, the extended part 
of an interface should not influence the flow field. This is achieved by 
deactivating the interface when generating the pore pressures. 

 

The properties of the concrete diaphragm wall are entered in a material set of the Plate 
type. The concrete has a Young's modulus of 35 GN/m2 and the wall is 0.35 m thick. 
The properties are listed in Table 6.2. 

Table 6.1.  Soil and interface properties 

Parameter Name Fill Sand Loam Unit 
Material model 
Type of material behaviour 
Soil unit weight above p.l. 
Soil unit weight below p.l. 
Horizontal permeability  
Vertical permeability  
Young's modulus 
Poisson's ratio 
Cohesion 
Friction angle 
Dilatancy angle 
Interface reduction factor 

Model 
Type 
γunsat

γsat

kx

ky

Eref

ν 
cref

ϕ 
ψ 
Rinter

MC 
Drained 
16 
20 
1.0 
1.0 
8000 
0.30 
1.0 
30 
0.0 
0.65 

MC 
Drained 
17 
20 
0.5 
0.5 
30000 
0.30 
1.0 
34 
4.0 
0.70 

MC 
Drained 
17 
19 
0.1 
0.1 
20000 
0.33 
8.0 
29 
0.0 
Rigid 

- 
- 
kN/m3

kN/m3

m/day 
m/day 
kN/m2

- 
kN/m2

° 
° 
- 

 

Table 6.2.  Properties of the diaphragm wall (plate) 

Parameter Name Value Unit 
Type of behaviour 
Normal stiffness 
Flexural rigidity 
Equivalent thickness 
Weight 
Poisson's ratio 

Material type 
EA 
EI 
d 
w 
ν 

Elastic 
12⋅106

0.12⋅106

0.346 
8.3 
0.15 

- 
kN/m 
kNm2/m 
m 
kN/m/m 
- 
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For the properties of the ground anchors, two material data sets are needed: One of the 
Anchor type and one of the Geogrid type. The Anchor data set contains the properties of 
the anchor rod and the Geogrid data set contains the properties of the grout body. The 
data are listed in Tables 6.3 and 6.4. 

Table 6.3.  Properties of the anchor rod (node-to-node anchor) 

Parameter Name Value Unit 
Type of behaviour 
Normal stiffness 
Spacing out of plane 
Maximum force 

Material type 
EA 
Ls

Fmax,comp 

Fmax,tens

Elastic 
2⋅105

2.5 
1⋅1015 

1⋅1015

- 
kN 
m 
kN 
kN 

 

Table 6.4.  Property of the grout body (geogrid) 

Parameter Name Value Unit 
Type of behaviour 
Normal stiffness 

Material type 
EA 

Elastic 
1⋅105

- 
kN/m 

 

Mesh generation 
For the generation of the mesh it is advisable to set the Global coarseness parameter to 
Medium. In addition, it is expected that stress concentrations will occur around the two 
grout bodies, and so a local refinement is proposed here. Select the four geogrids 
simultaneously (use the <Shift> key) and select Refine line from the Mesh menu. This 
process results in a mesh of approximately 590 elements. 

Initial conditions 
In the initial conditions, a water weight of 10 kN/m3 is entered. The initial water 
pressures are generated on the basis of a horizontal general phreatic level at y = 17 m 
(through points (0; 17.0) and (80.0; 17.0). 

Initially, all structural components are inactive. Hence, make sure that the plates, the 
node-to-node anchors and the geogrids are deactivated. The surface loads are also 
initially inactive. The initial stress field is generated by means of the K0 procedure using 
the default K0-values in all clusters. 

6.2 CALCULATIONS 

The calculation consists of six phases. In the first phase the walls are constructed and the 
surface loads are activated. In the second phase the first 3 m of the pit is excavated 
without connection of anchors to the wall. At this depth the excavation remains dry. In 
the third phase the first anchor is installed and pre-stressed. The fourth phase involves 
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further excavation to a depth of 7 m, including the de-watering of the excavation. This 
involves a groundwater flow analysis to calculate the new pore water distribution, which 
is a part of the definition of the third calculation phase. In the fifth phase the second 
anchor is installed and pre-stressed and the sixth phase is a further excavation (and de-
watering) of to the final depth of 10 m. 

All calculation phases are defined as Plastic calculations using Staged construction as 
Loading input and standard settings for all other parameters. The instructions given 
below are limited to a description of how the phases are defined within the Staged 
construction mode. 

Phase 1: 
• Activate the walls. 

• Activate the surface loads and assign a load value. Enter a Y-value = –10 kPa 
for the load on the left side and –5 kPa for the load on the right side of the 
excavation. 

  Phase 1 

Phase 2: 
• De-activate the upper cluster of the excavation. 

  Phase 2 

Phase 3: 
• Activate the upper geogrids 
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• Double-click the upper node-to-node anchors. A node-to-node anchor 
properties window appears with the anchor pre-stress options. Select the Adjust 
pre-stress force box and enter a pre-stress force of 120 kN/m. Click OK to 
close the window. 

  Phase 3 

 
Hint: A pre-stress force is exactly matched at the end of a finished staged 

construction calculation and turned into an anchor force. In successive 
calculation phases the force is considered to be just an anchor force and can 
therefore further increase or decrease, depending on the development of the 
surrounding stresses and forces. 

 

Phase 4: 
• Deactivate the second cluster of the excavation. 
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  Phase 4 

Now the boundary conditions for the groundwater flow calculation have to be entered. 
At the side boundaries, the groundwater head remains at a level of 17.0 m. The bottom 
boundary of the problem should be closed. The flow of groundwater is triggered by the 
fact that the pit is pumped dry. At the bottom of the excavation the water pressure is 
zero, which means that the groundwater head is equal to the vertical level (head = 13.0 
m). This condition can be met drawing a new general phreatic level and performing a 
groundwater flow calculation. Activating the interfaces during the groundwater flow 
calculation prevents flow through the wall. 

he
ad

=1
7m

 head=13m

he
ad

=1
7m

 

Closed boundary
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In order to prescribe correctly these boundary conditions, follow these steps: 

Click the 'switch' to go to the water pressures mode. 

• Select the Closed flow boundary button (black line) from the toolbar. Click the 
lower left point of the geometry; proceed to the lower right point and click 
again 

• Click the Selection button. 

• The interfaces on both sides of the wall should be activated by default in the 
water pressures mode, marking them as impermeable. Clicking an interface in 
the water pressures mode activates or deactivates the interface during 
groundwater calculations. An active interface is marked with an orange circle 
and is considered impermeable during groundwater calculations. Do not switch 
the interfaces below the walls to impermeable, those should remain permeable 
(inactive during the groundwater flow calculation). 

• Click the General phreatic level button and draw a new phreatic level. Start in 
(0.0; 17.0) and draw the phreatic level through (30.0; 13.0), (50.0; 13.0) and 
end in (80.0; 17.0). 

• Click the Generate water pressures button. Select Groundwater calculation 
from the Generate by box and click OK to start the groundwater flow 
calculation (the Iterative procedure can remain at the Standard setting). 

• After the groundwater calculation has finished, click the OK button in the 
calculation window. The window closes and the flow field is presented in the 
Output window.  

 
Hint: The results of a groundwater calculation can be viewed as Pore pressures, 

Flow field and Groundwater head. These options are available from the Stress 
menu. 

 

 

Figure 6.3  Active pore pressure contours resulting from groundwater calculation 

• Click the Update button to return to the staged construction mode. 

• Within the staged construction mode, click the Update button to return to the 
Calculation program. 
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Phase 5: 
• Activate the lower geogrids 

• Double-click the lower node-to-node anchors. In the Anchor window, select the 
Adjust pre-stress force box and enter a pre-stress force of 200 kN/m. Click OK 
to close the window. 

 

  Phase 5 

Phase 6: 
• Deactivate the third cluster of the excavation. 

• Click the 'switch' to go to the water pressures mode. 

• The boundary conditions were already defined in phase 3. They are still valid 
for the current groundwater calculation. However it is now necessary to lower 
the water level within the excavation to the new construction depth. In order to 
do this, draw a new General phreatic level from (0.0; 17.0) through points 
(30.0; 10.0), (50.0; 10.0) and (80.0; 17.0). Click the Generate water pressures 
button and select Groundwater flow from the Generate by box and click OK to 
start the groundwater flow calculation. 

• After the groundwater calculation has finished, click the OK button in the 
calculation window and view the results in the Output window. Click the 
Update button to return to the staged construction mode. 
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  Phase 6 
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After all calculation phases have been defined, some points for load-displacement 
curves should be selected (for example the connection points of the ground anchors on 
the diaphragm wall).  Start the calculation by clicking the Calculate button. 

6.3 OUTPUT 

Figure 6.4 (a) to (e) show the deformed meshes at the end of calculation phases 2 to 6. 
In the final situation, the walls have moved about 8 cm forward and the excavation 
bottom has risen just over 5 cm. Behind the wall there is a small settlement trough.  

 
(a) phase 2 

 

(b) phase 3 

 

(c) phase 4 
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(d) phase 5 

 
(e) final stage 

Figure 6.4 Deformed mesh stages (a) to (e) 

Figure 6.5 shows the principal effective stresses in the final situation. The passive stress 
state beneath the bottom of the excavation is clearly visible. It can also be seen that there 
are stress concentrations around the grout anchors. 

Figure 6.6 shows the bending moments in the left diaphragm wall in the final state. The 
two dips in the line of moments are caused by the anchor forces. 

The anchor force can be viewed by double-clicking the anchor. When doing this for the 
results of the third and the fifth calculation phase, it can be checked that the anchor force 
is indeed equal to the specified pre-stress force.  

 
Figure 6.5  Effective stresses, final stage 
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Figure 6.6  Bending moments in the left diaphragm wall in the final stage 

6.4 USING THE HARDENING SOIL MODEL 

In the previous example the Mohr-Coulomb model was used to model the soil 
behaviour. Although the Mohr-Coulomb model is often used it lacks particular aspects 
of soil behaviour such as the difference in stiffness between virgin-loading and 
unloading-reloading. Such aspects are taken into account in more advanced models like 
the Hardening Soil model. In the excavation modelled here the soil below the excavation 
is mainly subjected to unloading and subsequently shows a relatively stiff behaviour. 
The soil next to the wall is mainly subject to shear stresses and subsequently shows a 
less stiff behaviour. Though this soil behaviour could be captured by creating different 
clusters with different soil parameters below and next to the excavation pit, it is easier 
and more reliable to use the Hardening Soil model. Therefore, the same project is now 
modified so that all soil layers are modelled using the Hardening Soil model instead of 
the Mohr-Coulomb model. It is not necessary to create a new model; you can start from 
the previous model, modify it and store it under a different name.  

In order to modify the soil material sets take the following steps: 

• In PLAXIS Input open the previous file (“lesson4” or whichever name it was 
given) and save it under a different name. 

• Open the material sets database and double-click the first material data set 
“Fill”. This will open the material data set window. From the Material model 
combo box select Hardening Soil and proceed to the Parameters tab sheet. 
Enter values for ref

oedE , refE50 , ref
urE , m and in the Advanced model parameters 
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window for pref, νur and NCK0
 according to Table 6.5. Please note that the 

Advanced model parameters can be found by clicking the Advanced button on 
the Parameters tab sheet. The value of NCK0

 is equal to 1 - sinϕ and will be 
automatically calculated by PLAXIS after entering a value of “-1” in the 

NCK0
input box.  

Table 6.5.  Soil and interface properties 

Parameter Name Fill Sand Loam Unit 
Material model 
Type of material behaviour 
Soil unit weight above p.l. 
Soil unit weight below p.l. 
Horizontal permeability  
Vertical permeability  
Secant stiffness for CD triax. 
Tangent oedometer stiffness 
Unloading/reloading stiffness 
Power for stress depend. stiffn. 
Reference stress 
Poisson's ratio 
Lateral stress coefficient 
Cohesion 
Friction angle 
Dilatancy angle 
Interface reduction factor 

Model 
Type 
γunsat

γsat

kx

ky 
refE50
ref
oedE  
ref
urE  

m 
pref

νur 
NCK0

 

cref

ϕ 
ψ 
Rinter

HS 
Drained 
16 
20 
1.0 
1.0 
22000 
22000 
66000 
0.5 
100 
0.20 
0.5 
1.0 
30 
0.0 
0.65 

HS 
Drained 
17 
20 
0.5 
0.5 
43000 
43000 
129000 
0.5 
100 
0.20 
0.44 
1.0 
34 
4.0 
0.70 

HS 
Drained 
17 
19 
0.1 
0.1 
20000 
20000 
60000 
0.6 
100 
0.20 
0.52 
8.0 
29 
0.0 
Rigid 

- 
- 
kN/m3

kN/m3

m/day 
m/day 
kN/m2

kN/m2

kN/m2

- 
kN/m2

- 
- 
kN/m2

° 
° 
- 

 

 
Hint: The Hardening Soil parameters have been derived from the Mohr-Coulomb 

parameters by setting the E50 of the Hardening Soil model in the midpoint of 
each layer to the Eref of the Mohr-Coulomb model and deriving refE50  from this 
at the reference level pref=100 kPa (see eq. 5.2 of the Material Models 
manual).  ref

oedE  and ref
urE are assumed to be equal to refE50 and refE503  respectively. 

 

• Repeat this for all material data sets according to Table 6.5. 

• Continue to the initial conditions and regenerate the initial stresses using 
OCR=1 and POP=0 for all clusters. Though the initial stresses remain the same 
the regeneration is needed in order to generate the isotropic pre-consolidation 
stresses pp. Please note that it is not necessary to regenerate the mesh or the 
initial pore pressures. 
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• After regenerating the initial stresses save the project and continue to PLAXIS 
Calculations. 

• In PLAXIS Calculations make sure all phases are selected for calculation (blue 
arrows) and calculate the project. 

6.5 OUTPUT FOR THE HARDENING SOIL CASE 

Figure 6.7 shows the deformed mesh at the end of the final calculation phase. The walls 
have moved in approximately 7 cm and the excavation bottom has risen 3 to 4 cm. 

 

Figure 6.7 Deformed mesh final stage 

6.6 COMPARISON WITH MOHR-COULOMB 

A detailed comparison of the results from the Mohr-Couloumb and the Hardening Soil 
cases yields some important differences: 

• The excavation bottom rises less in the HS case than in the MC case; this is due 
to unloading behaviour of the Hardening Soil model. The Hardening Soil 
model behaves much stiffer in unloading than the Mohr-Coulomb model does, 
as the Mohr-Coulomb model has only a single stiffness. 

• The inward movement of the walls is less in the HS case than in the MC case; 
again this is due to the different unloading behaviour. 

• The settlement trough is larger in the HS case than in the MC case. This is due 
to the difference in vertical movement of the walls for both cases; for the 
Mohr-Coulomb model the excavation bottom rises more due to the softer 
unloading behaviour and pushes up the walls, which in turn influences the 
settlement trough. 

• The structural forces in the walls are higher in the HS case than in the MC case.  

Practical cases have proven that for excavations, where the unloading behaviour of the 
soil is very important, the Hardening Soil model gives more realistic results than the 
Mohr-Coulomb model.  
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7 CONSTRUCTION OF A ROAD EMBANKMENT (LESSON 5) 

The construction of an embankment on soft soil with a high groundwater level leads to 
an increase in pore pressure. As a result of this 'undrained behaviour' the effective stress 
remains low and intermediate consolidation periods have to be adopted in order to 
construct the embankment safely. During consolidation the excess pore pressures 
dissipate so that the soil can obtain the necessary shear strength to continue the 
construction process. 

This lesson concerns the construction of a road embankment in which the mechanism 
described above is analysed in detail. In the analysis three new calculation options are 
introduced, namely a consolidation analysis, an updated mesh analysis and the 
calculation of a safety factor by means of phi/c-reduction. 

 

Figure 7.1  Situation of a road embankment on soft soil 

7.1 INPUT 

Figure 7.1 shows a cross section of a road embankment. The embankment is 16.0 m 
wide and 4.0 m high. The slopes have a slope of 1:3. The problem is symmetric, so only 
one half is modelled (in this case the right half is chosen). The embankment itself is 
composed of loose sandy soil. The subsoil consists of 6.0 m of soft soil. The upper 3.0 
m of this soft soil layer is modelled as a peat layer and the lower 3.0 m as clay. The 
phreatic level coincides with the original ground surface. Under the soft soil layers there 
is a dense sand layer, which is not included in the model. 

Geometry model 
The embankment shown in Figure 7.1 can be analysed with a plane strain model. For 
this example 15-node elements are utilised. The standard units for Length, Force and 
Time are used (m, kN and day). A total width of 40 m is considered in the geometry 
model, starting from the embankment centre. The full geometry can be drawn using the 
Geometry line option. The deformations of the deep sand layer in Figure 7.1 are 
assumed to be zero. Hence, this layer is not included in the model and a fixed base is 
used instead. 
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The Standard fixities can be used to define the boundary conditions. The geometry 
model is shown in Figure 7.2. 

 
Figure 7.2  Geometry model of road embankment project 

Table 7.1.  Material properties of the road embankment and subsoil 

Parameter Name Clay Peat Sand Unit 
Material model 
Type of behaviour 
Soil unit weight above 
phreatic level 
Soil unit weight below 
phreatic level 
Horizontal permeability 
Vertical permeability 
Young's modulus  
Poisson's ratio 
Cohesion 
Friction angle 
Dilatancy angle 

Model 
Type 
γunsat 

 
γsat

kx

ky

Eref

ν 
cref

ϕ 
ψ 

MC 
Undrained 
15 
 
18 
1⋅10-4

1⋅10-4

1000 
0.33 
2.0 
24 
0.0 

MC 
Undrained 
8 
 
11 
2⋅10-3

1⋅10-3

350 
0.35 
5.0 
20 
0.0 

MC 
Drained 
16 
 
20 
1.0 
1.0 
3000 
0.3 
1.0 
30 
0.0 

- 
- 
kN/m3 

 
kN/m3

m/day 
m/day 
kN/m2

- 
kN/m2

° 
° 

 

Material sets and mesh generation 
The properties of the different soil types are given in Table 7.1. Three material sets are 
to be created, containing the data according to the table. The clay and the peat layer are 
undrained. This type of behaviour leads to an increase of pore pressures during the 
construction of the embankment. Assign the data to the corresponding clusters in the 
geometry model. After the input of material parameters, a simple finite element mesh 
may be generated using the Medium coarseness setting. Generate the mesh by clicking 
the Generate mesh button. 
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Initial conditions 
In the Initial conditions the water weight is set to 10 kN/m3. The water pressures are 
fully hydrostatic and based on a general phreatic level through the points (0.0; 6.0) and 
(40.0; 6.0).  

In addition to the phreatic level, attention must be paid to the boundary conditions for 
the consolidation analysis that will be performed during the calculation process. Without 
giving any additional input, all boundaries are draining so that water can freely flow out 
of all boundaries and excess pore pressures can dissipate in all directions. In the current 
situation, however, the left vertical boundary must be closed because this is a line of 
symmetry, so horizontal flow should not occur. The right vertical boundary should also 
be closed because there is no free outflow at that boundary. The bottom is open because 
below the soft soil layers the excess pore pressures can freely flow into the deep and 
permeable sand layer (which is not included in the model). The upper boundary is 
obviously open as well. In order to create the appropriate consolidation boundary 
conditions, follow these steps: 

Click the Closed consolidation boundary button (yellow line) in the toolbar. 
 

• Move to the upper point of the left boundary (0.0; 10.0) and click this point. 
Move to the lower point of the left boundary (0.0; 0.0) and click again. Click 
the right mouse button to finish this closed boundary. 

• Move to the upper point of the right boundary (40.0; 6.0) and click. Move to 
the lower point (40.0; 0.0) and click again. Finish this closed boundary. 

• Click the Generate water pressures button to generate the water pressures and 
the consolidation boundary conditions. 

After the generation of the water pressures, click the 'switch' to modify the initial 
geometry configuration. In the initial situation the embankment is not present. In order 
to generate the initial stresses therefore, the embankment must be deactivated first.  

 
Hint: Closed consolidation boundaries can only be defined by clicking existing 

geometry points. The program will automatically find intermediate geometry 
points. 

> Consolidation boundary conditions must be generated in the boundary nodes 
of the mesh. This is done together with the generation of water pressures. 
Hence, after introducing or changing consolidation boundaries, always click 
the Generate water pressures button. 

 

Click once in the two clusters that represent the embankment, just like in a staged 
construction calculation. When the embankment has been deactivated (the 
corresponding clusters should have the background colour), the remaining active 
geometry is horizontal with horizontal layers, so the K0 procedure can be used to 
calculate the initial stresses. The suggested K0-values of the clay and peat layer (based 
on Jaky's formula: K0 = 1 - sinϕ) can be accepted. After the generation of the initial 
stresses the input is complete and the calculations can be defined. 
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7.2 CALCULATIONS 

The embankment construction consists of two phases, each taking 5 days. After the first 
construction phase a consolidation period of 200 days is introduced to allow the excess 
pore pressures to dissipate. After the second construction phase another consolidation 
period is introduced from which the final settlements may be determined. Hence, a total 
of four calculation phases have to be defined. 

A consolidation analysis introduces the dimension of time in the calculations. In order to 
correctly perform a consolidation analysis a proper time step must be selected. The use 
of time steps that are smaller than a critical minimum value can result in stress 
oscillations. The consolidation option in PLAXIS allows for a fully automatic time 
stepping procedure that takes this critical time step into account. Within this procedure 
there are three main possibilities: Either consolidate for a predefined period, including 
the effects of changes to the active geometry (Staged construction), consolidate until all 
excess pore pressures in the geometry have reduced to a predefined minimum value 
(Minimum pore pressure) or consolidate for a given number of steps, using incremental 
multipliers to globally increase load systems in time or to apply rate loading 
(Incremental multiplier). The first two possibilities will be used in this exercise. 

To define the calculation phases, follow these steps: 

• The first calculation stage is a Consolidation analysis, Staged construction. In 
the General tab sheet select Consolidation from the Calculation type combo 
box. In the Parameters tab sheet, enter a Time interval of 5 days. Select Staged 
construction for the Loading input and click the Define button. Activate the 
first part of the embankment in the Geometry configuration window and click 
the Update button. Back in the Calculation window, click the Next button to 
introduce the next calculation phase. 

• The second phase is also a Consolidation analysis, Staged construction. This 
time no changes to the geometry are made as only a consolidation analysis to 
ultimate time is required. Enter a time interval of 200 days and click the Next 
button to introduce the next calculation phase. 

• The third phase is once again a Consolidation analysis, Staged construction. 
After selecting  Staged construction in the Parameters tab sheet enter a Time 
interval of 5 days. Click the Define button and activate the second part of the 
embankment. Click Update and enter the next phase. 

• The fourth phase is a consolidation analysis to a minimum pore pressure. In the 
Parameters tab sheet, select Minimum pore pressure from the Loading input 
box and accept the default value of 1 kN/m2 for the minimum pressure. 

Before starting the calculation, click the Select points for curves button and select the 
following points: As Point A, select the toe of the embankment. The second point (Point 
B) will be used to plot the development (and decay) of excess pore pressures. To this 
end, a point somewhere in the middle of the soft soil layers is needed, close to (but not 
actually on) the left boundary. After selecting these points, start the calculation. 



CONSTRUCTION OF A ROAD EMBANKMENT (LESSON 5) 

During a consolidation analysis the development of time can be viewed in the upper part 
of the calculation info window. In addition to the multipliers, a parameter Pmax occurs, 
which indicates the current maximum excess pore pressure. This parameter is of interest 
in the case of a Minimum pore pressure consolidation analysis, where all pore pressures 
are specified to reduce below a predefined value. 

7.3 OUTPUT 

After the calculation has finished, select the third and the fourth phase simultaneously 
(hold the <Ctrl> key on the keyboard while selecting these phases) and click the Output 
button. The Output window now shows the two deformed meshes, one after the 
undrained construction of the final part of the embankment and one after full 
consolidation. 

 
Figure 7.3  Displacement increments after undrained construction of embankment 

 
Figure 7.4  Excess pore pressures after undrained construction of embankment 

 
Figure 7.5  Excess pore pressure contours after consolidation to Pexcess < 1.0 kN/m2 
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Considering the results of the third phase (undrained construction), the deformed mesh 
shows the uplift of the embankment toe and hinterland due to the undrained behaviour. 
On evaluating the total displacement increments, it can be seen that a failure mechanism 
is developing (see Figure 7.3). In addition, Figure 7.4 shows the excess pore pressures 
distribution. It is clear that the highest excess pore pressure occurs under the 
embankment centre. 

It can be seen that the settlement of the original soil surface and the embankment 
increases considerably during the fourth phase. This is due to the dissipation of the 
excess pore pressures, which causes consolidation of the soil. Figure 7.5 shows the 
remaining excess pore pressure distribution after consolidation. Check that the 
maximum value is below 1.0 kN/m2. 

The Curves program can be used to view the development, with time, of the excess pore 
pressure under the embankment. In order to create such a curve, follow these steps: 

• Click the Go to curves program button in the upper left corner of the Output 
window. 

• Select New chart and select the current project from the file requester. 

• In the Curve generation window, select Time for the x-axis. For the y-axis, 
select Pore pressure – Excess pore pressure and select the point in the middle 
of the soft soil layers (Point B) from the Point combo box. After clicking the 
OK button, a curve similar to Figure 7.6 should appear. 

Figure 7.6 clearly shows the four calculation phases. During the undrained construction 
phases the excess pore pressure increases with a small increase in time while during the 
consolidation periods the excess pore pressure decreases with time. In fact, 
consolidation already occurs during construction of the embankment, as this involves a 
small time interval. From the curve it can be seen that more than 700 days are needed to 
reach full consolidation. 
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Figure 7.6  Development of excess pore pressure under the embankment 
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7.4 SAFETY ANALYSIS 

In the design of an embankment it is important to consider not only the final stability, 
but also the stability during the construction. It is clear from the output results that a 
failure mechanism starts to develop after the second construction phase.  

It is interesting to evaluate a global safety factor at this stage of the problem, and also 
for other stages of construction.  

In structural engineering, the safety factor is usually defined as the ratio of the collapse 
load to the working load. For soil structures, however, this definition is not always 
useful. For embankments, for example, most of the loading is caused by soil weight and 
an increase in soil weight would not necessarily lead to collapse. Indeed, a slope of 
purely frictional soil will not fail in a test in which the self weight of the soil is increased 
(like in a centrifuge test). A more appropriate definition of the factor of safety is 
therefore: 

Safety factor  = 
S

S
mequilibriufor    needed

available  maximum  

Where S represents the shear strength. The ratio of the true strength to the computed 
minimum strength required for equilibrium is the safety factor that is conventionally 
used in soil mechanics. By introducing the standard coulomb condition, the safety factor 
is obtained: 

Safety factor  = 
ϕσ
ϕσ

rnr

n

      c
      c

tan
tan

−
−  

Where c and ϕ are the input strength parameters and σn is the actual normal stress 
component. The parameters cr and ϕr are reduced strength parameters that are just large 
enough to maintain equilibrium. The principle described above is the basis of the 
method of Phi/c-reduction that can be used in PLAXIS to calculate a global safety factor. 
In this approach the cohesion and the tangent of the friction angle are reduced in the 
same proportion: 

c
c
r

  =
ϕ
ϕ

r 
 

tan
tan = ΣMsf 

The reduction of strength parameters is controlled by the total multiplier ΣMsf. This 
parameter is increased in a step-by-step procedure until failure occurs. The safety factor 
is then defined as the value of ΣMsf at failure, provided that at failure a more or less 
constant value is obtained for a number of successive load steps. 

The Phi/c-reduction calculation option is available in PLAXIS from the Calculation type 
list box on the General tab sheet. If the Phi/c-reduction option is selected the Loading 
input on the Parameters tab sheet is automatically set to Incremental multipliers. 

7-7 



TUTORIAL MANUAL 

7-8 PLAXIS Version 8 

To calculate the global safety factor for the road embankment at different stages of 
construction, follow these steps: 

• Click the Go to calculations program button to focus the Calculations window. 

• We first want to calculate the safety factor after the first construction stage. 
Therefore introduce a new calculation phase and select Phase 1 in the Start 
from phase list box. 

• In the General tab sheet, select a Phi/c-reduction calculation.  

• In the Parameters tab sheet the number of Additional steps is automatically set 
to 100 (instead of the default value of 250). In order to exclude existing 
deformations from the resulting failure mechanism, select the Reset 
displacements to zero option. The Incremental multipliers option is already 
selected in the Loading input box. Click the Define button to enter the 
Multipliers tab sheet. 

• On the Multipliers tab sheet, check that the first increment of the multiplier that 
controls the strength reduction process, Msf, is set to 0.1. The first safety 
calculation has now been defined. 

 
Hint: The default value of Additional steps in a Phi/c-reduction calculation is 100. 

In contrast to an Ultimate level calculation, the number of additional steps is 
always fully executed. In most Phi/c-reduction calculations, 100 steps are 
sufficient to arrive at a state of failure. If not, the number of additional steps 
can be increased to a maximum of 1000. 

> For most phi/c-reduction calculations Msf = 0.1 is an adequate first step to 
start up the process. During the calculation process, the development of the 
total multiplier for the strength reduction, ΣMsf, is automatically controlled by 
the load advancement procedure. 

 

• We now want to define the calculation of the safety factor after the second 
construction stage. Therefore introduce a new calculation phase and select 
Phase 3 as the phase to start from. This can be done in the General tab sheet of 
the Calculation program by clicking the combo box start from phase and 
choosing Phase 3. 

• In the General tab sheet select Phi/c-reduction from the Calculation type 
combo box.  

• In the Parameters tab sheet select the Reset displacements to zero option, select 
Incremental multipliers and click the Define button. 

• In the Multipliers tab sheet check that Msf is set to 0.1. 

• Finally we want to know the final safety factor of the embankment. Therefore 
introduce one more calculation stage and let it start from the fourth calculation 
phase.  

• In the General tab sheet select Phi/c-reduction as the calculation type. 
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• In the Parameters tab sheet select the Reset displacements to zero option. In 
addition select the Ignore undrained behaviour option because in this case the 
long term behaviour is considered. Select Incremental multipliers and click the 
Define button. 

• In the Multipliers window, check that Msf is set to 0.1. 

Before starting the calculations, make sure that only the new calculation phases are 
selected for execution (→); the others should be indicated with the √-sign. 

Evaluation of results 
Additional displacements are generated during a phi/c-reduction calculation. The total 
displacements do not have a physical meaning, but the incremental displacements in the 
final step (at failure) give an indication of the likely failure mechanism. In order to view 
the mechanisms in the three different stages of the embankment construction, select the 
phases 5, 6 and 7 simultaneously (use the <Ctrl> key) and click the Output button. 
Select for all windows the Total increments from the Deformations menu and change 
the presentation from Arrows to Shadings. The resulting plots give a good impression of 
the failure mechanisms (see Figure 7.7). The magnitude of the displacement increments 
is not relevant.  

 

Figure 7.7 Shadings of the total displacement increments indicating the most 
applicable failure mechanism of the embankment in the final stage 

The safety factor can be obtained from the Calculation info option of the View menu. 
The Multipliers tab sheet of the Calculation information window represents the actual 
values of the load multipliers. The value of ΣMsf represents the safety factor, provided 
that this value is indeed more or less constant during the previous few steps. 

The best way to evaluate the safety factor, however, is to plot a curve in which the 
parameter ΣMsf is plotted against the displacements of a certain node. Although the 
displacements are not relevant, they indicate whether or not a failure mechanism has 
developed.  

In order to evaluate the safety factors for the three situations in this way, follow these 
steps: 

• Click the Go to curves program button to start the Curves program. 

• Select a New chart and select the road embankment file from the file requester. 
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• In the Curve generation window, select the total displacement of the 
embankment toe (Point A) for the x-axis. For the y-axis, select Multipliers and 
select ΣMsf from the Type combo box. As a result, the curve of Figure 7.8 
appears. 

The maximum displacements plotted are not relevant. It can be seen that for all curves a 
more or less constant value of ΣMsf is obtained. Hovering the mouse cursor over a point 
on the curves, a box showing the exact value of ΣMsf can be obtained. 
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Safety factor (long term) 1.34 

 

Figure 7.8  Evaluation of safety factor for three stages of the construction process 

7.5 UPDATED MESH ANALYSIS 

As can be seen from the output of the Deformed mesh at the end of consolidation 
(stage 4), the embankment settles over half a metre within two years of the start of 
construction. Part of the sand fill that was originally above the phreatic level will settle 
below the phreatic level.  

As a result of buoyancy forces the effective weight of the soil that settles below the 
water level will change, which leads to a reduction of the effective overburden in time. 
This effect can be simulated in PLAXIS using the Updated mesh and Updated water 
pressures options. For the road embankment the effect of using these options will be 
investigated. 

Open the current project in the Input program and select Save as from the File menu. 
Save the project under a different name. Now click the Go to Calculation program 
button and open the new project. All phases will be marked for calculation.  
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To change the calculation to an Updated mesh analysis, do the following: 

• Select Phase 1 and click the Advanced button below the Calculation  type list 
box. Check the Updated mesh and Updated water pressures options in the 
Advanced general settings window. Click OK to return to the calculation 
window. 

• Repeat this step for all calculation phases 2, 3 and 4. 

• Delete phases 5, 6 and 7. 

• Start the calculation. 

When the calculation has finished, open the Curves program to compare the settlements 
for the two different calculation methods. 

• Select a New chart and select the road embankment calculation using updated 
mesh from the file requester. 

• In the Curve generation window select time for the x-axis and select the total 
displacement of the embankment toe (Point A) for the y-axis. 

To compare those with the displacements from the calculation without the updated mesh 
option, add a curve from the previous calculation, without the updated mesh option. 

• From the File menu, choose to Add curve, from another project. 

• From the file requester, select the road embankment calculation without 
updated mesh. 

• In the Curve generation window, select the same point (Point A), for which 
deformation versus time will be plotted. Click OK to add the curve. 

The default graph generated also includes the displacements calculated during the Phi/c-
reduction stages. These displacements are not of interest at the moment and can be 
removed from the curve. 

• Select Curve from the Format menu and click the Phases button. 

• In the Select phases window, deselect the Phi/c-reduction phases, i.e. phases 5, 
6 and 7. Click OK to return to the Curve settings window and click OK again to 
update the graph. 

Now only the displacements during the construction and consolidation phases are 
plotted. To change the vertical scale of the graph: 

• Select Graph from the Format menu and change the Scaling of the Y-axis to 
Manual. Enter a maximum value of 0.5. Click OK to update the graph. 

In Figure 7.9 it can be seen that the settlements are less when the Updated mesh and 
Updated water pressures options are used. This is partly because the Updated mesh 
procedure includes second order deformation effects by which changes of the geometry 
are taken into account, and partly because the Updated water pressures procedure 
results in smaller effective weights of the embankment. This last effect is caused by the 
buoyancy of the soil settling below the (constant) phreatic level. The use of these 
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procedures allows for a realistic analysis of settlements, taking into account the positive 
effects of large deformations. 
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Figure 7.9  Settlements of the toe of the embankment using updated mesh calculation 
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8 SETTLEMENTS DUE TO TUNNEL CONSTRUCTION (LESSON 6) 

PLAXIS has special facilities for the generation of circular and non-circular tunnels and 
the simulation of a tunnel construction process. In this chapter the construction of a 
shield tunnel in medium soft soil and the influence on a pile foundation is considered. A 
shield tunnel is constructed by excavating soil at the front of a tunnel boring machine 
(TBM) and installing a tunnel lining behind it. In this procedure the soil is generally 
over-excavated, which means that the cross sectional area occupied by the final tunnel 
lining is always less than the excavated soil area. Although measures are taken to fill up 
this gap, one cannot avoid stress re-distributions and deformations in the soil as a result 
of the tunnel construction process. To avoid damage to existing buildings or foundations 
on the soil above, it is necessary to predict these effects and to take proper measures. 
Such an analysis can be performed by means of the finite element method. This lesson 
shows an example of such an analysis. 

8-1 
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Figure 8.1  Geometry of the tunnel project with an indication of the soil layers 

The tunnel considered in this lesson has a diameter of 5.0 m and is located at an average 
depth of 20 m. The soil profile indicates four distinct layers: The upper 13 m consists of 
soft clay type soil with stiffness that increases approximately linearly with depth. Under 
the clay layer there is a  2.0 m thick fine sand layer. This layer is used as a foundation 
layer for old wooden piles on which traditional brickwork houses were built. The pile 
foundation of such a building is modelled next to the tunnel. Displacements of these 
piles may cause damage to the building, which is highly undesirable. Below the sand 
layer there is a 5.0 m thick deep loamy clay layer.  
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This is one of the layers in which the tunnel is constructed. The other part of the tunnel 
is constructed in the deep sand layer, which consists of dense sand and some gravel.  
This layer is very stiff. As a result only 5.0 m of this layer is included in the finite 
element model; the deeper part is considered to be fully rigid and modelled by 
appropriate boundary conditions. The pore pressure distribution is hydrostatic. The 
phreatic level is located 3 m below the ground surface (at a level of y = 0 m). Since the 
situation is more or less symmetric, only one half (the right half) is taken into account in 
the plane strain model. From the centre of the tunnel the model extends for 30 m in 
horizontal direction. The 15-node element is adopted for this example. 

8.1 GEOMETRY 

The basic geometry including the four soil layers, as shown in Figure 8.1 (but excluding 
the tunnel and the foundation elements), can be created using the geometry line option. 
Since the ground surface is located at 3.0 m above the reference level, the Top parameter 
is taken at +3.0 m in the General settings and the Bottom at -22.0 m. For the generation 
of the tunnel we will use the tunnel designer, which is a special tool within PLAXIS that 
enables the use of circle segments (arcs) and lines to model the geometry of a tunnel. 
The tunnel considered here is the right half of a circular tunnel and will be composed of 
four sections. After generating the basic geometry, follow these steps to design the 
circular tunnel: 

Click the Tunnel button in the toolbar. The Tunnel designer window appears, 
with a number of options in its toolbar for creating tunnel shapes. Select Half  
tunnel - Right half from the toolbar. 

• The tunnel designer will show a default (half) tunnel shape composed of three 
sections of which the lower one (Section 1) is selected, as indicated in Figure 
8.2. The right side of the window shows some geometrical values. 

• Keep the Type of tunnel on the default value of a Bored tunnel. Make sure that 
the lower tunnel section is selected (if not, select it by clicking with the mouse 
in the lower section). 

• The values in the table represent the properties of the first tunnel section. For a 
circular (bored) tunnel the radius can be entered here. Enter a radius of 2.5 m. 
The result of this action is directly visible in the drawing. 

• The value below the radius represents the angle over which the section extends. 
Enter an angle of 90 degrees (which is the maximum angle of one section). 

• The local x- and y-coordinates of the first arc centre point is always located at 
the local origin (x=0; y=0) for a bored tunnel.  

• Make sure that the options Shell and Interface are selected for this section.  

• Proceed to the next section (2) by clicking the right arrow at the bottom of the 
window. Alternatively, you may click the second tunnel section in the designer 
window. 
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• Enter an angle of 90 degrees. It is not necessary, nor possible, to enter the 
radius of the second tunnel segment. This value is automatically adopted from 
the first tunnel segment in case of a circular tunnel. 

• Make sure that the Shell and Interface options are selected for section 2. 

 

Figure 8.2  Tunnel designer with current tunnel model 

 
Hint: A shell and interface can be assigned directly to all tunnel sections by clicking 

the corresponding buttons at the top of the tunnel window. 
> A tunnel lining consists of curved plates. The lining properties can be 

specified in the material database for plates. Similarly, a tunnel interface is 
nothing more than a curved interface. 

> In the tunnel as considered here the sections do not have a specific meaning as 
the tunnel lining is homogeneous and the tunnel will be constructed at once.  

> In general, the meaning of sections becomes significant when: 
> It is desired to excavate or construct the tunnel (lining) in different stages.  
> Different tunnel sections have different lining properties.  
> One would consider hinge connections in the lining (hinges can be added after 

the design of the tunnel in the general drawing area).  
> The tunnel shape is composed of arcs with different radii (for example NATM 

tunnels). 
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• In the Shape group box there are two parameters. The Symmetric tunnel 
parameter can be selected for whole tunnels. The Circular tunnel option is 
automatically selected for bored tunnels. 

• The tunnel has now been completely defined. Click the OK button to close the 
tunnel designer. 

• Back in the draw area, the tunnel must be included in the geometry model. This 
is done by entering the global position of the origin of the local tunnel axes. 
Click the existing point at position (0.0; -17.0) (5.0 m above the bottom of the 
geometry model). The tunnel will be drawn with its centre at this location.  

The wooden piles below the building are end bearing piles. Only a small part of the total 
bearing capacity results from skin friction. To correctly model this behaviour, the piles 
will be modelled using a combination of plates and node-to-node anchors. The building 
itself will be represented by a stiff plate founded on the node-to-node anchors. 

• Draw three separate plates from (5.0;-10.0) to (5.0;-11.0), from (15.0;-10.0) to 
(15.0;-11.0) and from (5.0;3.0) to (15.0;3.0). 

• Connect the top of the pile toes to the foundation plate using node-to-node 
anchors, as indicated in Figure 8.1. 

Boundary conditions 
• Click the Standard fixities button to apply the appropriate boundary conditions. 

In addition to the standard displacement fixities, fixed rotations are introduced 
to the upper and lower point of the tunnel lining. 

 
Hint: In the Standard fixities option, a plate that extends to a geometry boundary 

that is fixed in at least one direction obtains fixed rotations, whereas a plate 
that extends to a free boundary obtains a free rotation. 

 

Material properties 
The material properties for the four different soil layers are listed in Table 8.1. For all 
layers the material behaviour is set to drained since we are interested in the long term 
deformations.  

For the upper clay layer we use the advanced option to let the stiffness increase with 
depth. Therefore a value of Eincrement is entered in the Advanced parameters window. The  
value of Eref  becomes a reference value at the reference level yreference. Below yreference the 
actual value of E increases with depth according to:  E(y) = Eref + Eincrement (yreference - y). 

The data sets of the two lower soil layers include appropriate parameters for the tunnel 
interfaces. In the other data sets the interface properties just remain at their default 
values. Enter four data sets with the properties as listed in Table 8.1 and assign them to 
the corresponding clusters in the geometry model. To enter the advanced parameters for 
the Clay data set, click the Advanced  button in the Parameters tab sheet.  
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Table 8.1.  Material properties of soil in the tunnel project 

Parameter Name Clay Sand Dp. Clay Dp.sand Unit 
Material model 
Material beh. 
Soil unit weight  
above phreatic level 
Soil unit weight  
below phreatic level 
H. permeability  
V. permeability  
Young's modulus  
Increase E 
Reference level 
Poisson's ratio 
Cohesion 
Friction angle 
Dilatancy angle 
Interface strength 

Model 
Type 
γunsat 

γsat

kx

ky

Eref

Eincr

yref

ν 
cref

ϕ 
ψ 
Rinter

MC 
Drained 
15 

18 

1⋅10-4

1⋅10-4

3400 
400 
0.0 
0.33 
5.5 
24 
0.0 
rigid 

MC 
Drained 
16.5 

20 

1.0 
1.0 
80000 
- 
- 
0.3 
1.0 
31 
1.0 
rigid 

MC 
Drained 
16 

18.5 

1⋅10-2

1⋅10-2

10000 
- 
- 
0.33 
4.0 
25 
0.0 
0.7 

MC 
Drained 
17 

21 

0.5 
0.5 
120000 
- 
- 
0.3 
1.0 
33 
3.0 
0.7 

- 
- 
kN/m3

kN/m3

m/day 
m/day 
kN/m2

kN/m3

m 
- 
kN/m2

° 
° 
- 

In addition to the four data sets for the soil and interfaces, three plate and one anchor 
data set have to be created. The properties for those plates are listed in Table 8.2 and 
Table 8.3. Assign the Lining data set to the tunnel lining and the Pile toe data set to the 
two pile toes. The building data set is assigned to the foundation plate representing the 
building. The weight of this beam also represents the load of the entire building. Assign 
the Pile data set to the two node-to-node anchors. 

Table 8.2.  Material properties of the plates 

Parameter Name Lining Pile toe Building Unit 
Type of behaviour 
Normal stiffness 
Flexural rigidity 
Equivalent thickness 
Weight 
Poisson's ratio 

Type 
EA 
EI 
d 
w 
ν 

Elastic 
1.4⋅107 

1.43⋅105

0.35 
8.4 
0.15 

Elastic 
2⋅106 

8⋅103

0.219 
2.0 
0.2 

Elastic 
1⋅1010 

1⋅1010

3.464 
25 
0.0 

 
kN/m 
kNm2/m 
m 
kN/m/m 
- 

 
Table 8.3.  Material properties of the anchors 

Parameter Name Pile Unit 
Material type 
Normal stiffness 
Spacing between 
anchors 

Type 
EA 
Lspacing

Elastic 
2⋅106 

1 

 
kN 
m 
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Mesh generation 
In this example the 15-node element is used as the basic element type. This means that 
the mesh is more accurate than when using the 6-node element. The global coarseness 
parameter can remain at its default value (Coarse). It can be expected that stress 
concentrations occur around the tunnel and the pile toes. Therefore the mesh should be 
refined in these areas. Select the two clusters inside the tunnel and use the Refine cluster 
option in the Mesh menu. Select the two plates representing the pile toes and select 
Refine line from the Mesh menu. 

Initial conditions 
The water weight should be taken 10 kN/m3. The water pressures can be generated on 
the basis of a general phreatic level at a level of y = 0.0 m. 

Before generating the initial stresses, make sure that the building, piles, pile toes and 
tunnel lining are deactivated. The K0 procedure can be used to generate the initial 
effective stresses with the appropriate values of K0. 

8.2 CALCULATIONS 

To simulate the construction of the tunnel it is clear that a staged construction 
calculation is needed in which the tunnel lining is activated and the soil clusters inside 
the tunnel are deactivated. Deactivating the soil inside the tunnel only affects the soil 
stiffness and strength and the effective stresses. Without additional input the water 
pressures remain. To remove the water pressure inside the tunnel the two soil clusters in 
the tunnels must be set to dry in the water conditions mode and the water pressures 
should be regenerated. To create this input, follow these steps. 

• The first calculation phase is used to activate the building. Select a Plastic 
calculation using Staged construction. Within staged construction mode 
activate the pile toes, anchors and the foundation plate. Click Update to return 
to the calculation window. 

• The second calculation phase is a plastic calculation, Staged construction. On 
the Parameters tab sheet, select the reset displacements to zero checkbox. 
Click the Define button and activate the tunnel lining and deactivate the two 
soil clusters inside the tunnel. 

• Click the 'switch' to proceed to the water pressures mode. Click the Selection 
button and select both soil clusters inside the tunnel simultaneously (using the 
<Shift> key). Double-click one of the clusters while holding the <Shift> key. 
This will show the Cluster pore pressure distribution window. In this window 
select Cluster dry and click OK to return to the water pressure mode. 

• Click the Generate water pressures button to generate the water pressures. In 
the resulting plot it can be seen that there are indeed no water pressures inside 
the tunnel. Click the Update button to return to the water pressures mode. 
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• Within the water pressures mode, click the Update button to return to the 
calculations window. 

In addition to the installation of the tunnel lining, the excavation of the soil and the de-
watering of the tunnel, the volume loss is simulated by applying a contraction to the 
tunnel lining. This contraction will be defined in a staged construction calculation phase: 

• Click the Next button to introduce a next calculation phase. 

• Select a plastic calculation, Staged construction and click the Define button. 

• Double-click the centre of the tunnel to open the Tunnel contraction window. 
Enter a contraction of 2% and click OK to return to the geometry mode and 
Update to return to the calculations window. 

• Select some characteristic points for load-displacement curves (for example the 
corner point at the ground surface above the tunnel and the corner points of the 
building). 

• Start the calculations. 

 
Hint: The contraction of the tunnel lining by itself does not introduce forces in the 

tunnel lining. Eventual changes in lining forces as a result of the contraction 
procedure are due to stress redistributions in the surrounding soil or to 
changing external forces. 

 

8.3 OUTPUT 

After the calculation, select the last two calculation phases and click the Output button. 
The Output program is started, showing the deformed meshes at the end of the 
calculation phases.  

As a result of the second calculation phase (removing soil and water out of the tunnel) 
there is some settlement of the soil surface and the tunnel lining shows some 
deformation. In this phase the axial force in the lining is the maximum axial force that 
will be reached. The lining forces can be viewed by double-clicking the lining and 
selecting force related options from the Force menu (see Figure 8.3). 

The third calculation phase shows the results due to the simulation of the volume loss. 
The deformed mesh indicates a settlement trough at the ground surface, which is 
influenced by the presence of the building. (see Figure 8.4). The plot of effective 
stresses, Figure 8.5, shows that arching occurs around the tunnel. This arching reduces 
the stresses acting on the tunnel lining. As a result, the axial force in phase is lower than 
that after the second calculation phase. The bending moments, however, are larger (see 
Figure 8.6). The influence of the tunnel contraction on the foundation can be seen in a 
plot of the relative shear stresses or plots of the displacements of the pile toes. 
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Figure 8.3  Axial forces and Bending moments in the lining after the second phase. 

 
Figure 8.4  Deformed mesh after construction of the tunnel 

 
Figure 8.5  Effective stresses after construction of the tunnel 
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Figure 8.6  Axial forces and bending moments in the lining after the third phase 

8.4 USING THE HARDENING SOIL MODEL 

During both the tunnel boring and the contraction phase the soil around the tunnel is 
unloaded. The tunnel exercise will now be calculated using the Hardening soil model as 
this model incorporates a difference in stiffness behaviour between unloading or 
reloading and virgin loading. 

In order to change the project take the following steps: 

• Open the previously calculated tunnel project in PLAXIS Input and save it under 
a different name. 

• Open the material sets database and change the four soil material sets from 
Mohr-Coulomb to Hardening Soil using the parameters given in Table 8.4. 

• Go to the initial conditions and regenerate the initial stresses using OCR=1 and 
POP=0 for all clusters. 

• Save the project and continue to PLAXIS Calculations. Make sure all phases are 
selected for calculation and recalculate the project. 

 
Hint: The Hardening Soil parameters have been derived from the Mohr-Coulomb 

parameters by setting the E50 of the Hardening Soil model in the midpoint of 
each layer to the Eref of the Mohr-Coulomb model and deriving refE50  from this 
at the reference level pref=100 kPa (see eq. 5.2 of the Material Models 
manual).  ref

oedE  and ref
urE are assumed to be equal to refE50 and refE503  respectively. 
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Table 8.4.  Material properties of soil in the tunnel project 

Parameter Name Clay Sand Dp. Clay Dp.sand Unit 
Material model 
Material beh. 
Soil unit weight 
above phreatic level 
Soil unit weight 
below phreatic level 
H. permeability  
V. permeability  
Secant stiffness CD 
triaxial test  
Tangent oedometer 
stiffness 
Un/reload. modulus 
Power for stress law 
 
Reference stress 
Poisson's ratio 
Lateral stress coeff. 
Cohesion 
Friction angle 
Dilatancy angle 
Interface strength 

Model 
Type 
γunsat 

γsat 

kx

ky
refE50

 
 

ref
oedE  

 
ref
urE  

m 
pref

νur 
NCK0

 
cref

ϕ 
ψ 
Rinter

HS 
Drained 
15 

18 

1⋅10-4

1⋅10-4

9700 
 
9700 
 
29100 
1.0 
 
100 
0.20 
0.59 
5.5 
24 
0.0 
rigid 

HS 
Drained 
16.5 

20 

1.0 
1.0 
98000 
 
98000 
 
294000 
0.5 
 
100 
0.20 
0.48 
1.0 
31 
1.0 
rigid 

HS 
Drained 
16 

18.5 

1⋅10-2

1⋅10-2

10000 
 
10000 
 
30000 
0.9 
 
100 
0.20 
0.58 
4.0 
25 
0.0 
0.7 

HS 
Drained 
17 

21 

0.5 
0.5 
120000 
 
120000 
 
360000 
0.5 
 
100 
0.20 
0.46 
1.0 
33 
3.0 
0.7 

- 
- 
kN/m3

kN/m3

m/day 
m/day 
kN/m3

 
kN/m3

 
kN/m3

- 
 
kN/m2

- 
- 
kN/m2

° 
° 
- 

8.5 OUTPUT FOR THE HARDENING SOIL CASE 

Output results show the same tendencies as when the Mohr-Coulomb model was used, 
which is described in Section 8.3.  

 
Figure 8.7  Deformed mesh after construction of the tunnel 
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8.6 COMPARISON WITH THE MOHR-COULOMB CASE 

After the tunnel construction phase there are some clear differences between both cases: 

• In the HS case the tunnel is less deformed due to the stiffer soil behaviour; this 
results in approximately 20% smaller bending moments in the HS case while 
the axial forces remain the same. 

• Due to the stiffer soil behaviour underneath the tunnel in the HS case the tunnel 
experiences significantly less uplift. This results in a deeper settlement trough 
at ground level compared to the Mohr-Coulomb model. 

During the tunnel contraction phase both cases show similar displacements around the 
tunnel but there is a distinct difference in the displacements at a distance of the tunnel. 

• With the Hardening Soil model the soil around the tunnel is subject to lower 
strain levels so that the soil behaves more like a rigid block and the 
displacements around the tunnel due to contraction are therefore still fully 
noticeable at ground level. This causes a deeper settlement trough and also up 
to 10% higher structural forces in the foundation plate of the existing building. 

Finally it should be noticed that the bending moments at the top of the lining reduce 
considerably in case of Hardening Soil compared to Mohr-Coulomb, due to the reduced 
deformation of the lining. 
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A.2  CALCULATIONS MENU 
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A.4  CURVES MENU 
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APPENDIX B - CALCULATION SCHEME 

FOR INITIAL STRESSES DUE TO SOIL WEIGHT 

 

Horizontal 
surface 

Yes No 

Start

Ready

K0-procedure

 
Initial stresses 

 
Σ-Mweight = 1 

Gravity loading 

Plastic calculation 
Loading input:     

Total multipliers 
Σ-Mweight = 1 

 

 
Examples of non-horizontal surfaces, and non-horizontal weight stratifications are: 
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